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CHAPTER 1
About the add-on

This chapter contains the following topics:

1. Concepts overview

2. How this guide is organized

1.1 Concepts overview
The TIBCO EBX® Digital Asset Manager Add-on allows you to manage digital asset storage,
classification, and versioning. Once you've created a storage location, you can use the add-on to upload
assets and enrich them with metadata.

Note

You can also use the add-on's API to connect to a third-party digital asset management
system. This allows you to use the third-party tool for management purposes, but still
link assets to TIBCO EBX® data model fields.

The asset governance process can include adding descriptive metadata to assets, creating versions,
deactivating/deleting and backing up and restoring assets. The add-on allows you to perform these
tasks from simple-to-navigate screens. See  Managing digital assets [p 44] for more information.

Asset storage in Drives
The EBX Digital Asset Manager Add-on uses Drives as physical storage locations for assets. You can
use Drives as part of asset governance by creating one for asset types, assets from different sources
or, any other organizational requirement. For information on creating a, and uploading assets into a
Drive, see  Getting started with the add-on. [p 14]

Digital asset components
A Digital asset component (D.A.C.) links a storage location (Drive) to a data model field configured
to use the add-on. You can then attach assets from the Drive to the field. For example, a data model
table containing product information could have a field containing assets that show one or more views
of the product.
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1.2 How this guide is organized
This guide contains the following sections:

Section Contents

Getting started This section covers initial add-on configuration. Most of the steps in this section require
administrative privileges.

Uploading and attaching assets This chapter describes how to upload assets to a Drive and attach them to a data model
field. Add-on configuration must be complete prior to performing these tasks.

Previewing assets This chapter describes behavior when previewing assets.

Configuring asset filters This chapter outlines the different types of filters the add-on offers.

Managing digital assets Digital asset governance can include managing basic asset information, tags, metadata and
versions—all topics covered in this section. Additionally, this section discusses how to
create a backup of, and restore assets.
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Getting started
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CHAPTER 2
Configuration process overview

Assets uploaded using the add-on can benefit from its management capabilities. In order to upload,
store and link assets with a data model, you must complete the configuration tasks below:

• Add a media field to a data model using the mediaType data type. For detailed steps to complete
this task, see Configuring the data model [p 15].

• Create an asset storage location, or Drive. For detailed steps to complete this task, see Creating
a Drive [p 19].

• Use a Digital asset component (D.A.C.) to link the media field and Drive. For detailed steps to
complete this task, see Linking a Drive and data model field [p 23].

The following map summarizes the tasks required to complete this process:
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CHAPTER 3
Configuring the data model

This chapter contains the following topics:

1. Configuration task map

2. Steps to complete Task 1

3.1 Configuration task map
The following map shows where you are in the add-on configuration process:

The following section outlines the steps to complete Task 1: Configuring the data model.

See also

Creating a Drive [p 19]

Linking a Drive and data model field [p 23]

Configuration process overview [p 14]

3.2 Steps to complete Task 1
To attach a digital asset to a record, you must add a field to the data model. This field's data type must
be set to mediaType. The following steps describe how to accomplish this:

1. Locate and open an existing, or create a new data model to which you want to add asset
management capabilities.

2. In the Navigation pane, open Configuration > Included data models and click the + icon to add
a data model.
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3. Select the Packaged in module option and in the Model properties group, choose ebx-addon-
dama for the Module name and select /WEB-INF/ebx/schema/media-type.xsd for the Path in
module field.

4. After saving and closing, create a field using the mediaType data type in the desired table by
selecting Create child from the table's services menu and using the following options:

• Enter a name and optionally a label and description.

• For the Kind of element, select Group.

• Select Reuse an existing type.
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• Select Included data models as the Data type and choose Media type from the drop-down
menu.

5. Use the group's Minimum/Maximum number of values properties to specify the number of
assets that users can attach to this field. If you are using this field to display images on a tile view,
the Maximum number of values property must be set to 1. Additionally, the group can only
contain one field; the media type field.

Attention
If you configure options for this field's Default views and tools, it can prevent users from
accessing asset management functionality. Additionally, the value of a Path variable for a Media
type field must specify an absolute path. If not, a PathAccesException is thrown.
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6. After clicking Create, you can publish the data model and, if needed, create a dataset.

See also

Creating a Drive [p 19]

Linking a Drive and data model field [p 23]

Configuration process overview [p 14]
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CHAPTER 4
Creating a Drive

This chapter contains the following topics:

1. Configuration task map

2. Steps to complete Task 2

3. Troubleshooting Drive error messages

4.1 Configuration task map
The following map shows where you are in the add-on configuration process:

The following section outlines the steps to complete Task 2: Creating a Drive.

See also

Linking a Drive and data model field [p 23]

Configuring the data model [p 15]

Configuration process overview [p 14]

4.2 Steps to complete Task 2
A Drive specifies an asset storage location and options related to acceptable file size and storage
limitations. The following example points to a location on the local machine, however the API also
allows you to point to a cloud storage location. For more information, see the Java API documentation.
To create a Drive:

1. Navigate to Administration > User interface > TIBCO EBX® Digital Asset Manager Add-on >
Drive and open the Drive table. This table stores asset storage configuration information.
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2. Create a new Drive configuration. When filling required fields, you can hover your mouse over
the property and click the ? icon to view online help, or you can refer to the Drive group section
in this guide. The following image and list highlight some configuration options.

1) Connector: Set the type of connector to use for this
Drive:

• Amazon S3: Allows you to create a Drive where
assets are stored and managed in an Amazon S3
bucket.

• Azure Blob: Allows you to create a Drive where
assets are stored and managed in Microsoft Azure.



Documentation > User Guide > Getting started > Creating a Drive

TIBCO EBX® Digital Asset Manager Add-on 21

• Custom connector: Allows you to connect to an
externally managed location by using a custom
implementation.

• External manager: Allows you to use the API to
connect to an externally managed storage location.

• Default connector: Allows you to create a default
Drive where asset storage and management tasks
are handled by the add-on.

Physical root path: (For Default connector) Specify
the physical storage location for assets.
External management class: (For External manager)
Specify the class that defines an externally managed
storage location. See Connecting to alternative storage
locations [p 112] for more information.

2) Specify Drive level permissions.

3) Determine the maximum amount of physical disk space
this Drive can use for asset storage.

4) Create a custom image configuration to set limits on the
physical size (width/height) of uploaded images.
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4.3 Troubleshooting Drive error messages
The following table provides troubleshooting tips for Drive configuration error messages.

Message Cause

Your path is a file; not a folder The path specified in the Physical root path field points to a file when it should point
to a folder.

You do not have write permission in this
folder

The add-on does not have sufficient system permission to manage assets in the
specified location. You may need a system administrator to raise permission levels,
or use a different storage location.

This folder is not empty You will see this message if the storage location you choose already contains files.
When creating a new Drive, the storage location should be empty to avoid potential
duplication of an asset's unique identifier.

Cannot create folder using this path If the folder you specify doesn't exist, the add-on checks whether it can create the
folder using the specified path. This message displays when it cannot create the
folder automatically.

Comment Displays comments applied to this asset version.

Current version Indicates whether this version is considered the current version.

Digital asset The digital asset of which this is a version.

See also

Linking a Drive and data model field [p 23]

Configuring the data model [p 15]

Configuration process overview [p 14]
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CHAPTER 5
Linking a Drive and data model field

This chapter contains the following topics:

1. Configuration task map

2. Steps to complete Task 3

5.1 Configuration task map
The following map shows where you are in the add-on configuration process:

The following section outlines the steps to complete Task 3: Linking a Drive and field.

See also

Creating a Drive [p 19]

Configuring the data model [p 15]

Configuration process overview [p 14]

5.2 Steps to complete Task 3
To complete the final configuration task you link the data model field and Drive created in Tasks 1
and 2, respectively.
The following steps show how to link the media field you created in the data model with the Drive
(storage location):

1. Navigate to Administration > User interface > TIBCO EBX® Digital Asset Manager Add-on >
D.A.C and open the Digital asset component table and create a new record.

2. Fill the required fields, save and close. It is important to note that by default no restrictions apply
to the types of files users can upload. If you want to exclude certain file types, you can enable
the Restrict file upload option and select acceptable types in Supported extensions field. The
add-on includes a set of default image extensions. If you want to allow other file types, you can
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create them in the File extension table located in the Reference data domain. Additionally, you
can use the Blacklisted extensions field to manually exclude available file types.
Additionally, the final required property, Tag cloud, isn't available to edit until you've saved the
initial configuration.
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The following image highlights D.A.C. functionality:

1) Link the physical storage location selected in the Drive
menu to the Media-type field in the data model.

2) Options to govern asset upload:

• Asset name pattern: Select a regular expression to
enforce a naming convention for asset physical file
names. The add-on will prevent users from uploading
files if their names do not match this pattern.

• Restrict file upload: When enabled, the Supported
extensions group displays and allows you to specify an
approved set of file extensions for upload.

• Blacklisted extensions: Enter a list of file extensions
you want the add-on to blacklist.

3) These options determine:
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• How assets display after users attach them to data
model fields.

• Whether the asset thumbnails display in the table views
and how they display in the Drive view.

Enabling thumbnail display and upload in the tabular view
You can specify that an asset's thumbnail and an icon to upload and attach assets display when
viewing a table. You can also customize the thumbnail display size. Enabling upload of assets from
the tabular view is convenient for end users since they won't have to open each record to attach assets.
Additionally, users can preview and download assets from the tabular view.
Thumbnail display behaves as follows:

• When no assets are attached, the field is left blank.

• If multiple assets are attached, the first thumbnail displays. Or if multiple types of assets are
attached, the first asset whose type supports thumbnails displays.

• If the asset type does not support thumbnails, the type's icon displays. When no icon is specified
for the asset type, the default icon displays.

To enable table display of thumbnails and allow upload and attach:

1. If one does not already exist, create a view configuration and set the View mode to Table view.
For instructions on creating a view configuration, see Specifying the view mode [p 62].

2. Open the D.A.C. associated with the data model field that you want to display thumbnails.

3. Use the EBX tabular view  drop-down menu to select the desired view configuration.

4. Save and close. The following image shows an example thumbnail display:

See also

Creating a Drive [p 19]

Configuring the data model [p 15]

Configuration process overview [p 14]
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CHAPTER 6
Uploading and attaching assets

This chapter contains the following topics:

1. Overview

2. Using quick upload mode

3. Using standard upload mode

6.1 Overview
The add-on provides standard and quick-upload functionality. Administrators can use permission
settings to determine this behavior. See Setting the upload mode [p 27] for more information. Even
when quick-upload is available, users can still access the Drive to upload and attach assets. See the
following sections for more information:

• Using quick upload mode [p 27]

• Using standard upload mode [p 28]

Setting the upload mode
Administrators can specify which upload mode users can access. If you enable quick-upload, users
will not see notification of duplicate assets, or errors indicating upload of invalid assets. For instance,
if a user attempts to upload a file that does not meet conditions specified in D.A.C. settings, the file
displays in the field with a red border and will not be attached to the field when saving.
To change the upload mode:

1. In the add-on's administrative area, navigate to and open the D.A.C. on which you want to adjust
settings.

2. Open the appropriate user permission group and set the Allow to quick upload and attach
property to the appropriate setting. Save and close.

6.2 Using quick upload mode
Use the following steps to upload and automatically attach an asset to a field:

1. Create a new, or open an existing record in the dataset containing the media type field to which
you want to attach an asset.
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2. Click the Upload button that displays in the media type field. Note: You cannot use the Upload
option when the maximum number of assets are already attached to the field.

3. In the pop-up window that displays, you can browse to select the files to upload and attach to the
field. Once the add-on finishes attaching assets, you can edit their information. See Management
overview [p 44] for more information. Also, note that the quick-upload option displays no errors,
or warnings during the upload process. However, if you've attempted to attach an assets that
violates requirements for this field, it displays with a red outline indicating an error and it will not
be attached to the field when saving. You can mouse over the asset to see information pertaining
to the error.

4. After assets have been attached to the field, be sure to save before exiting.

6.3 Using standard upload mode
The following topics describe how to upload assets and attach them to a data model field:

• Upload and automatically attach assets [p 28]

• Upload and attach in a Drive [p 31]

• Upload assets via administrative access [p 31]

• Attaching existing assets to a field [p 32]

Attention
The field and Drive must be properly configured before uploading and attaching assets. See Linking
a Drive and data model field [p 23] for more information.

Upload and automatically attach assets
If the Drive linked with a field doesn't contain the desired asset, use the following steps to upload and
automatically attach an asset to a field:

1. Initiate the upload process in one of the following ways:
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• If enabled by an administrator, select the upload icon that displays in the tabular view.

• Create a new, or open an existing record and click the Upload button that displays in the
media type field. Note: You cannot use the Upload option when the maximum number of
assets are already attached to the field.

2. In the pop-up window that displays, you can drag and drop, or browse to select the files to upload
and attach to the field. The following image highlights features in the upload screen. Once the
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add-on finishes attaching assets, you can edit their information. See Management overview [p

44] for more information.

1) If your Drive is configured to allow duplicates, the
yellow icon overlay indicates an identical asset exists in
the Drive. Use the Accept duplicate(s) option below to
accept or reject upload of duplicates. When duplicates
are not allowed, the red icon overlay displays and you
cannot upload the asset.

2) The red icon overlay indicates the asset does not
meet D.A.C requirements. Mouse-over the icon for
additional information.

3) Select to browse you file system for another file to
upload.

4) Drive indicates where these assets are uploaded. Use
the Target folder menu to select a folder location for
the uploaded assets.
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5) Enter the tags to apply to the assets included in this
upload.

Upload and attach in a Drive
The following steps describe how to upload an asset and attach it to a field using the Drive view:

1. Create a new, or open an existing record in the dataset containing the media type field to which
you want to attach an asset.

2. Click the Drive button that displays in the media type field to open the Drive view.

3. In the Digital assets pane mouse over the + menu and select Add new assets.

4. In the pop-up window that displays, you can drag and drop, or browse to select the files to upload.
If you've dropped files into the upload window and want to browse to select additional files, just
click the large plus thumbnail. The upload window also allows you to add tags which the add-
on applies to each asset in this upload. When adding tags, you can select from existing, or create
new tags by adding text and clicking the Enter key.

5. Click Attach and upload. Note that you have the additional option here of selecting Upload to
upload assets to the Drive without attaching them to the field. Once assets have uploaded, you
can select them to perform additional actions. The Management overview [p 44] section covers
related topics in more detail.

Upload assets via administrative access
If you have administrative privileges, you can use perform the following steps to upload an asset:

1. Navigate to Administration > User interface > TIBCO EBX® Digital Asset Manager Add-on >
Digital asset and from the Digital asset table's Actions menu and select Upload a new digital
asset.

2. Browse to select the desired file.

3. You can create a label, description, version name, comments and tags. When adding tags, you can
select from existing, or create new tags by adding text and pressing the Enter key.

4. Use the Drive drop-down list to indicate the Drive to which you want to add this asset.

5. Click Upload. After the process completes, the upload window refreshes and you can repeat these
steps to upload additional assets.
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Once you've uploaded assets, you can manage information such as label, description, state, tags and
other metadata. The section, Management overview [p 44], covers the asset management topic in
detail.

Attaching existing assets to a field
If you have previously used the add-on to upload files to a Drive, you can quickly attach them to
the field by:

1. Clicking Drive to open the Drive view.

2. Attach assets:

• Individual assets: Hover your mouse over an asset and select the paperclip icon.

• Multiple assets: Select multiple assets and click the paperclip icon at the top of the screen.
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3. Select one or more assets to attach. Select Attachments to show thumbnails of any assets attached
to the field. Detach all assets by selecting Detach all, or select individual assets to open a preview
with additional actions available.
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CHAPTER 7
Previewing assets

For supported file types, the add-on opens a preview when:

• You hover your mouse over an asset and select the  icon.

• You click an asset's thumbnail when viewing a table.

If you preview:

• an image: the add-on displays a full-size view and you can click to zoom.
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• a video: the add-on automatically plays the video and enables basic playback controls.

• a document: the add-on loads the document for viewing. From the preview, you can access
standard viewer features such as zoom, navigation, and search.

Note

To preview DOC files in some languages, such as Vietnamese, Japanese, and
Chinese, their respective language packs must be installed on the deployment
environment.
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Management overview [p 44] describes additional options available when previewing an asset from
the Drive view. The following table provides additional information pertaining to asset previews:

Asset type Notes

MP4 Currently, the add-on supports previewing and thumbnail generation for videos with
the H.264 codec and AAC, or MP3 audio format.

PDF The add-on does not support:

• Text search for older PDFs that use JPEG2000, or JBIG formats.

• Previewing files larger than 20MB.

Documents (DOCX, PPTX, XLS,
XLSX)

The add-on performs some conversion to display document previews. Certain
style elements may display differently in the preview. If the add-on cannot create a
preview, and error message displays and it allows you to download the asset. When
viewing PPT or PPTX previews, text is not selectable and the search function is
disabled. Also, note that previews of charts in these document types do not display.

The add-on supports preview functionality for Word 2007 and newer DOCX files.
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CHAPTER 8
Configuring asset filters

This chapter contains the following topics:

1. Overview

2. Filtering records containing assets

3. Adding a custom filter

8.1 Overview
The add-on includes the following types of filters that administrators can configure:

• Filters can apply to tables and display records based on the presence of attached digital assets.
Once configured, users can filter records using the EBX® table filter. For more information, see
Filtering records containing assets [p 39].

• A Java class can implement a programmatic filter that only allows users to view assets that meet
certain criteria. Once a developer implements the class, an administrator can include it as part of
a D.A.C. configuration. The filter is essentially transparent to users as the add-on automatically
applies it when they view assets. For more information, see Adding a custom filter [p 40].

8.2 Filtering records containing assets
Administrators can activate a filter that allows users to display records based on the presence of
attached assets. To enable filtering:

1. Open the desired model in the DMA.

2. Navigate to Configuration > Add-ons and create a new record.

3. In the Name field, select Digital Asset Manager.

4. Save, close, and publish the data model.

Users can access filter functionality via the EBX® table filter. The filter's TIBCO EBX® Digital
Asset Manager Add-on search group displays all fields in the current table configured to accept
asset attachments. For each field specify a value of:

• is null to show records without attachments in this field.
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• is not null to show records with attachments in this field.

8.3 Adding a custom filter
A custom filter implemented in a Java class can provide fine-grained control over what users can view
in the add-on's Drive view. See the API documentation for information on the interface and methods
required for this type of filter. Once the class has been created, configuration only requires that you
include the filter class in a D.A.C. configuration. The process is outlined below:

1. Open the desired record in the Digital asset component table.
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2. In the Custom filter field, enter the fully qualified name of the Java class that implements the
filter.

3. After saving and closing filter, the add-on applies filter functionality. The assets displayed for
users in the Drive view are based on their permissions and the filter.
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Managing
digital assets
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CHAPTER 9
Management overview

This chapter contains the following topics:

1. Overview of digital asset management

9.1 Overview of digital asset management
The add-on makes it quick and easy to find the specific digital asset you need with sophisticated
searching, sorting, and information editing capabilities. In addition to options available to
administrators, users can launch the following activities from the Drive view:

• Upload new assets.

• Attach assets to a data model field.

• Use criteria to sort and filter assets.

• Select assets to view their details.

• Download, share, deactivate and delete assets.

• Move assets from one Drive to another.

• Create folders and move assets between folders

To access the Drive view:

• Navigate to and open a data model record containing a field attached to a Drive.
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• As shown below, click the Drive button.
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The following image and list highlight some components of this view (with no assets selected):

1) The Folder navigation pane allows you to switch between
available Drives and folders.

2) The breadcrumb shows the current table and record.

3) • The  icon toggles displays of this Drive's folder
pane.

• Click Select all to select all assets in this Drive.
After selecting all, or individual assets, additional icons
display that allow you to interact with the selections.

• The + menu includes two options that allows you to
upload new assets and create new folders for this Drive.
Once you create a new folders, you can select and

move assets to them by clicking the  and using the
displayed options to select the desired folder.

4) • Use the View menu to switch between Grid view and
List view. The grid option displays larger thumbnails
and fewer assets and folders. The more compact list
option displays assets and folders in a table layout with
additional details visible.

• Set the sort order to ascending or descending and use
the drop-down menu to specify the sort criteria.

5) Use the filter and Attachments pane to locate assets and
view assets attached to the current field, respectively.

As shown below, you can use the filter to locate assets. You can:
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• Enter keywords and search the asset's label, description, and physical name. Use the menu to
specify whether the search looks for the exact search term, or text that contains the search term.
This option defaults to Contains.

• Filter results using file extensions and asset types.

• Use creation date, last update, and asset tags to filter results.
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Select Attachments to display this pane and manage assets attached to the current field. Select Detach
all to detach all assets from this field, or individually remove them using the corresponding X icon:

When you select an asset in the Attachments pane, an enlarged view displays. From this view you
can use the icons in the top-right corner to:

• Download the selected asset. A window displays and allows you to choose the download location.

• Deactivate the asset. After deactivating an asset, only administrators can re-activate it. A
deactivated asset no longer displays in the Drive view. To re-activate the asset: Navigate to
Administration > User interface > TIBCO EBX® Digital Asset Manager Add-on > Digital asset.
In the Digital asset table, double-click the asset to activate. Use the State drop-down list to update
the asset, save, and close.

• Permanently delete the asset. When you permanently delete an asset, the add-on physically deletes
it from the Drive.

• Share via email. Opens your email client with the selected asset attached to a new email.

Administrators can perform the same actions mentioned above. Additionally, they can use the add-
on's administrative tools to backup/restore assets. The following sections describe how to:

• Edit an asset's basic information. See Editing asset information [p 51].
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• Create Tag clouds and tags, and apply them to assets. See Tags and tag clouds [p 57].

• Create new versions of an asset and choose the asset considered the current version. See Managing
digital asset versions [p 59].

• Create metadata categories and apply them to assets, backup and restore assets, configure
additional Drive options, and set user permissions. See Additional configuration options [p 61].

Moving assets to other Drives or folders
You can move assets and folders to other Drives and folders. This can help you organize and classify
your assets. This feature is also useful when you want to use a new Drive with an existing DAC.
To move assets to another Drive:

1. Open the Drive containing the assets you want to move.

2. Click to select the desired assets or folders.

3. Select the  icon.

4. Use the Move to pop-up to select the destination Drive and folder, then click Confirm.

To move assets or folders to another folder:

1. Open the Drive containing the assets you want to move.

2. Click to select the desired assets or folders.

3. Use one of the following methods to move the selections:

• Drag the selected items to the desired folder in the Drive view.

• Select the  icon, use the options in the pop-up to select the destination, and click Confirm.

Sharing assets
The add-on allows you to share assets via links in email, permalinks, or asset URLs. To share assets:

1. Open the Drive containing the assets you want to share.

2. Select one or more assets. Note that if you want to share using a URL, only select a single asset.

Note

The URL link expiration time defaults to 30 minutes. However, an
administrator can adjust this limit in the ebx.properties file using the
ebx.addon.dama.rest.token.timeout property.

3. Click the  icon and choose how you want to share the asset.
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CHAPTER 10
Editing asset information

This chapter contains the following topics:

1. Overview

2. Editing asset metadata

10.1 Overview
Modifications to asset metadata are either isolated, or applied globally. Your access rights, and where
you make the change from determine their scope. When changes are isolated, they only impact the
current dataspace. For example, when you make changes in a child dataspace, they do not propagate
to the parent. Global changes are propagated to any location where an asset is used. If you:

• Are a business user and access edit functionality from a record's details view, any changes you
make are isolated to the current dataspace.

• Have administrative privileges and access edit functionality using the Manage digital assets
service, changes apply globally. When editing assets with this method, the Manage digital
assets screen might not reflect changes users have made using the Drive view. Note that as an
administrator you can still edit from a record's details view if you want to keep your changes local.
When you delete a D.A.C, any asset modifications made in the local dataspace (that are related
to the deleted D.A.C) are lost. Assets are reset to their initial state.

Note

The above behavior applies to asset versions, labels and descriptions. Changes to tags,
state, and custom metadata are always applied globally.

10.2 Editing asset metadata
To edit an uploaded asset's general information, tags, metadata, and manage versions:
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• As shown below, in the mediaType field, users can hover their mouse over an asset and select the
information icon. If the record is read-only, its information displays, but actions aren't permitted.

Attention
Changes made using this method are isolated to the current dataspace.

• From TIBCO EBX® Digital Asset Manager Add-on, administrators can select Manage digital
assets from the Actions menu. This view allows you to switch between Drives to edit any asset.
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Once you've located it, click the desired asset and in the Details pane, click the Edit icon above
the image.

Attention
Changes made using this method are propagated to all dataspaces.

The following three tabs display in the Edit digital asset screen:
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• The Information tab allows you to view and edit the asset's label, description, state and tag
information. You can only edit the asset's state if you have sufficient permissions. The following
section, Tags and tag clouds [p 57], describes these features in more detail.
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• The Version management tab allows you to create new asset versions, edit the version name and
comment attributes, delete asset versions, download versions, and select the current version. The
Managing digital asset versions [p 59] section covers these topics.

• The Custom metadata tab allows you to add custom metadata to an asset. See Creating metadata
categories [p 61] for more information.
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CHAPTER 11
Tags and tag clouds

This chapter contains the following topics:

1. Working with tags

2. Using tag clouds

11.1 Working with tags
Tags provide descriptive metadata about assets. By creating tags based on relevant keywords that
accurately define and describe assets, you enable filters and searches to retrieve the best results. To
ensure consistency and accuracy, it's a good practice to double-check all asset metadata against an
expected outcome.
A tag cloud facilitates grouping of related tags. A single tag can belong to multiple clouds.
Administrators can make one or more tag clouds available to each D.A.C.
As described in the following section, you can create tags dynamically when uploading assets, or
predefine tags to apply to assets at anytime.

Creating tags and applying them to assets
You can create tags in the following ways:

• When uploading an asset, you can enter a new, or select an existing tag. If you enter a new tag, the
add-on automatically adds it to the asset and stores the new tag for later use. The add-on stores
these tags in the tag clouds associated with this field through the D.A.C.

• If you have access to EBX® administrative features, you can navigate to Administration > User
interface > TIBCO EBX® Digital Asset Manager Add-on > Classification and use the Tag and
Tag cloud tables for creation. These tags will be available to users when uploading or editing
an asset.

In addition to applying tags when uploading an asset, you can add tags when:

• Editing an asset:

• When viewing an asset, click the Edit icon to display the Edit digital asset screen.

• From the Information tab, you can add, or remove tags. Just be sure to save your changes
and refresh the asset when finished.

• Managing assets as an administrator. While under Administration > User interface > TIBCO
EBX® Digital Asset Manager Add-on, open the Actions menu and select Manage digital assets.
Select the desired asset and click the Edit icon to add, or remove tags.
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11.2 Using tag clouds
If you have administrative privileges, you can create tag clouds and manage which tags are included
in each cloud. The following steps describe the process:

1. In the TIBCO EBX® Digital Asset Manager Add-on administration area, navigate to
Classification > Tag cloud.

2. Click the '+' icon to create a new tag cloud and provide a label and description.

3. After saving, you can add tags to this cloud by creating new, or using the Actions menu to
associate existing tags with this cloud.

You can open any tag cloud and use its Actions menu to:

• Associate existing tags with this cloud.

• Delete tags from the system.

• Remove tags from the cloud.

• Duplicate tags for modification (tags must be unique)

• Move tags from this cloud to a different cloud.
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CHAPTER 12
Managing digital asset versions

Keeping versions of digital assets allows you to re-purpose versions, or revert to an older version if
needed. Even though multiple asset versions may exist, only versions designated as the current version
display in the Mosaic and Drive views.

Note

You can attach duplicate files to the same field. When the add-on sees that the asset is
a duplicate, a screen displays that allows you to preview the asset and choose whether
to continue, or cancel.

To create a new version of an asset or change the current version:

1. Access the Edit digital asset view:

• When viewing a record with attached assets, select an asset's  icon. Any changes made to
the asset's version are isolated to the current dataspace.

• Administrators can select Manage digital assets from a dataset's Actions menu. Then select

an asset to open an expanded view and select the  icon. Any changes made to the asset's
version are propagated to all dataspaces.

2. Select the Version management tab. (If you do not need to upload a new file and are only
switching to a different version, tick the radio button in the Current version column of the desired
asset, and skip to step 7).

Note

From this view, administrators can delete asset versions by selecting versions to
delete and clicking Actions > Delete versions. There must be at least one version of
an asset. An error message displays if you try to delete the only version.

3. Browse to upload a new file. The uploaded file must have the same file extension as the original
asset.

4. Optionally, add a Version name, Comment and select the Current version checkbox to
automatically make this the current version. If you designate this asset as the current version, you
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can also enable the Update label option. This option updates the asset's label shown in the Drive
view to the current version's file name.

5. Click Create new version. The add-on automatically applies any existing tags and metadata to
the new version.

6. Save and close to exit.
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CHAPTER 13
Additional configuration options

This chapter contains the following topics:

1. Creating metadata categories

2. Backing up and restoring

3. Allocating Drive disk space

4. Limiting image size

5. Specifying the view mode

6. Whitelisting and blacklisting file formats

7. Setting user permissions

13.1 Creating metadata categories
In addition to tags, the add-on allows you to create your own categories of metadata to enrich assets.
After applying metadata categories to assets, you can further describe the assets by adding metadata
values. To perform these tasks:

1. Navigate to Administration > User interface > TIBCO EBX® Digital Asset Manager Add-on >
Reference data > Metadata nature and create a new record to define a category of metadata.

2. Access the Edit digital asset view:

• When viewing a record with attached assets, select an asset's  icon.

• Administrators can select Manage digital assets from a dataset's Actions menu. Then select

an asset to open an expanded view and select the  icon.

3. Select the Custom metadata tab and add a new value. While in this tab, you can also edit and
remove existing metadata. Be sure to save and refresh after completing your changes.

13.2 Backing up and restoring
The add-on allows you to take a single action to create a backup of all the assets it manages. When
you restore the files, you'll have to enter new paths for Drives included in the backup.
To create a backup:

1. Navigate to Administration > User interface > TIBCO EBX® Digital Asset Manager Add-on.

2. From the Actions menu > Services group, select Backup.
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3. Enter a name for the zip file and click Backup.

4. After the process completes, you can select Download to save a copy of the backup file.

To restore assets:

1. Navigate to Administration > User interface > TIBCO EBX® Digital Asset Manager Add-on.

2. From the Actions menu > Services group, select Restore.

3. Click Choose file to navigate to the backup file's location.

4. After selecting the file click Next.

5. A table listing all backed up Drives displays. Enter new paths, and click the Restore checkbox
for Drives you want to restore. An important note: If you choose not to restore specific Drives,
they will no longer be available.

6. Click Restore.

13.3 Allocating Drive disk space
When you create a Drive configuration, you point to a system folder to use as the Drive's physical
location. You can specify how much space you want to allocate to the Drive with the Max usable
space property. Once asset storage reaches this threshold, you can no longer upload assets to this
Drive, unless you physically delete assets to make room.

13.4 Limiting image size
You can use an image configuration to limit the physical size (width/height) of images. Once you've
created a configuration, you can add it to any Drive, or D.A.C. The configuration used by a D.A.C.
cannot allow for larger images than that used by the Drive.

13.5 Specifying the view mode
A view configuration determines how assets display when attached to a data model field.
Administrators can create configurations and use them in D.A.C.s. To create a view configuration:

1. Navigate to Administration > User interface > TIBCO EBX® Digital Asset Manager Add-on >
D.A.C. > View configuration.

2. When you open an existing, or create a new record you can choose from the following options:

• Mosaic view: Displays a tiled view of the assets. When you select this option, you'll be able
to set the number of assets that display in rows and columns. You can also choose whether
the view scrolls vertically, or horizontally to display additional assets.
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• List view: Displays assets in vertical list.

• Table view: Enables display asset thumbnails when viewing a table. Use the available options
to set the thumbnail size.

3. Decide whether assets display as their associated icons, or as thumbnails. When you choose:

• To display icons, the assets display with their associated icon (if one exists).

• To display thumbnails, you can set the thumbnail size and whether users can select an asset
to expand it.

4. Choose whether quick action icons always display, or only display when users mouse over an
assets thumbnail.

The following list of sample images show the outcomes of using the options mentioned above.
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• List view using thumbnails:
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• List view using icons:
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• Mosaic view with thumbnails:
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• Mosaic view with icons:

13.6 Whitelisting and blacklisting file formats
By default, the add-on allows upload of all file types. However, you may want to allow a set of
file formats and block others, whitelist and blacklist respectively. The add-on allows you to add to
a set of predefined file extensions. At the Drive level, you can restrict asset upload to only these
file extensions. Alternatively, you could manually enter file extensions to blacklist. The D.A.C.
level inherits permissions specified at the Drive level. However, you can override these settings. For
example, you may have two different D.A.C.s linked to the same Drive. You could change permissions
in the D.A.C.s so that only one of them can upload PDF files.
The following two settings are located in Administration > User interface > TIBCO EBX® Digital
Asset Manager Add-on in the Drive and Digital asset component tables:

• When enabled, the Restrict file upload option in a Drive record restricts asset upload to only
the asset file types listed in the Reference data > File extension table. When enabled in a D.A.C.
record, you can further refine restrictions by selecting options in the Supported extensions field.
If you would like to include additional file extensions in the Supported extensions list, see the
Adding new file extensions [p 68] section below.

• The Blacklisted extensions option only displays when the Restrict file upload option is disabled.
This field allows you to manually enter file extensions to exclude from a Drive or D.A.C. You
can use commas, semi-colons, periods, or whitespace to separate a list of extensions to blacklist.
For example: exe, bat, msi, etc.
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Adding new file extensions
To enable upload and management of additional file formats:

Note

The following steps require administrative privileges.

1. Navigate to Administration > User interface > TIBCO EBX® Digital Asset Manager Add-on >
Reference data > File extension.

2. Create a new record and fill in the following fields:

• Business code: A user friendly name for this file extension.

• Filename extension: Enter the filename suffix used to identify this file type.

• Digital asset type: Choose an asset type from the drop-down list. This list populates with
options from the Digital asset type table. You can create types in the table, or click + Create
in the drop-down list to create a new type.

• Icon → Select, or upload an icon used to identify this file extension type. The add-on stores
all icons in the [ON] Icon drive.

3. Save and close.

13.7 Setting user permissions
If you have administrative access, you can set user permissions. Drives and D.A.C.s apply
permission settings to user profiles and grant/restrict viewing, uploading, downloading, versioning
and deleting. With the ability to apply permissions at two levels (Drive/D.A.C.), you can fine-tune
asset management.
As an example, you may want allow a user to upload assets to a Drive. However, you may not want
this same user to upload, attach, or edit any assets attached to a particular field. To accomplish this,
you can grant appropriate access for the Drive and restrict access with the D.A.C.

Note

The add-on supports EBX® restriction policy functionality. For more in-depth
information on restriction policies, see the EBX® User Guide and Reference Guide.
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CHAPTER 14
Finding and removing unused assets

The add-on provides functionality to locate and remove assets not attached to a field—an effective
way to tidy-up the Digital asset table. As described below, administrators use a two part process to
identify unused assets and select assets for removal:

1. Navigate to Administration > User interface > TIBCO EBX® Digital Asset Manager Add-on >
Digital asset
and select the Digital asset table.

2. From the table's Actions menu, select Identify unused assets. After analysis, the add-on displays
only assets not attached to a field.

3. Select any assets you wish to remove and from the table's Actions menu, select Permanently
Delete (Physically delete). Press OK in the warning dialog to remove all selected assets.
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CHAPTER 15
Enabling asset management from

perspectives
Administrators can attach the Manage digital asset service to EBX® perspectives. This service allows
full control over all assets contained in a Drive. See the EBX® product documentation for more
information on creating perspectives and how they work.
To add add-on functionality to a perspective:

1. Select [ebx-addon-dama] Manage digital assets from the Action menu.

2. Use the required Dataspace and Dataset fields to specify the location of the media type fields.

3. Enter one or more Drive id's—which can be found in the add-on's Drive table—in the Input
parameters group Drive field. When entering multiple Drives, separate the entries using a
semicolon. If you leave this field blank, the perspective will be able to access any Drive associated
with the specified dataset.
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CHAPTER 16
Configuring an external Drive

The add-on allows administrators to create a Drive that connects to an externally managed asset storage
location. For example, you could connect to a cloud storage location. This allows externally managed
assets to be attached to EBX® data model fields.
A developer must programatically implement connection details and any third-party requirements
using the add-on's API. For details and examples, see Connecting to alternative storage locations [p

112]. Once necessary implementation steps are complete, you can create a Drive that connects to
external storage by:

1. Navigating to Administration > User interface > TIBCO EBX® Digital Asset Manager Add-on
> Drive and open the Drive table. This table stores asset storage configuration information.
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2. Creating a new Drive configuration. When filling required fields, you can hover your mouse over
the property and click the ? icon to view online help, or you can refer to the Drive group section
in this guide. The following image highlights some configuration options for an external Drive.

3. After saving and closing, you can link the Drive to a data model field using a Digital Asset
Component (D.A.C.). For instructions, please see Configuring the data model [p 15] and Linking
a Drive and data model field [p 23].
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CHAPTER 17
Connecting to an Amazon S3 bucket

This chapter contains the following topics:

1. Concepts overview

2. Configuring a Drive and Amazon S3 connector

17.1 Concepts overview
Administrators can create a Drive that connects to an Amazon S3 storage location. This allows you to
attach assets to fields in EBX® while managing their storage outside of EBX®. Most add-on features
are available when using this type of Drive. However, the add-on does not handle versioning in this
case and its features are disabled.
Setup requires updating EBX® configuration properties in addition to add-on configuration tasks. The
following section provides the steps to complete these tasks.

Attention
Some steps require access to the server where EBX® is running and others require administrative
access to add-on configuration settings.

17.2 Configuring a Drive and Amazon S3 connector
To configure a Drive to use an Amazon S3 connector:

1. Add the following properties to your ebx.properties file:

• ebx.addon.dama.aws.accessKey=<YourAccessKey>

• ebx.addon.dama.aws.secretKey=<YourSecretKey>

Note

You might be required to stop and restart your server to complete this step.

2. From the Administration panel, select: TIBCO EBX® Digital Asset Manager Add-on > Drive
> Drive.

3. Create a new record.

4. After adding a label and description, use the Connector menu to select Amazon S3.
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Fill in the required fields. If you have questions about one of the properties, hover your mouse
over it and select the '?' to view its tooltip.
Please note that:

• The Bucket name is validated to ensure input is valid, but the name you enter must match
your S3 bucket.

• The Folder name can be selected from existing folders, or you can click Create to add a
new folder.

5. After saving and closing, you must create a D.A.C. [p 23] to connect the Drive to a data model field.
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CHAPTER 18
Connecting to Azure

This chapter contains the following topics:

1. Concepts overview

2. Configuring a Drive and Azure connector

3. Retrieving Microsoft Entra ID values

4. Retrieving the Storage Account Key

18.1 Concepts overview
Administrators can create a Drive that connects to an Azure storage location. This allows you to attach
assets to fields in EBX® while managing their storage outside of EBX®. Most add-on features are
available when using this type of Drive. However, some asset metadata cannot be propagated to Azure,
such as labels, descriptions, and tags. The metadata can be added in EBX®, but not stored in Azure.

Attention
Digital assets stored in Azure cannot use the % symbol in the file name. See the official Microsoft
Azure documentation for more information.

Setup requires updating EBX® configuration properties in addition to add-on configuration tasks. The
following section provides the steps to complete these tasks.

Attention
Some steps require access to the server where EBX® is running and others require administrative
access to add-on configuration settings.
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Authentication methods
You can choose from the authentication methods described in the following table:

Option Why choose this What you configure

Microsoft Entra ID (recommended) • Least privilege: assign only required blob roles (e.g. Storage
Blob Data Contributor).

• Rotation: secrets/certificates can be rotated without regenerating
account keys.

• Auditability: operations are attributed to a service principal
identity.

• Policy: supports Conditional Access and governance controls.

• Risk reduction: avoids distribution of long-lived shared keys.

App registration (client ID/secret or certificate), RBAC role
assignment, tenant ID

Shared Key (fallback/legacy) Short-term migration or temporary access when Entra ID isn't
available

Storage account name and one account key

18.2 Configuring a Drive and Azure connector
To configure a Drive to use an Azure connector:

1. Select and configure one authentication method in you ebx.properties file:

• Recommended: Microsoft Entra ID (Azure AD)
Add all of the following properties:

• ebx.addon.dama.azure.tenant.id=<tenantId>

• ebx.addon.dama.azure.client.id=<clientId>

• ebx.addon.dama.azure.client.secret=<clientSecret>

See also  Retrieving Microsoft Entra ID values [p 79]

Attention
Use Entra ID for least-privilege (RBAC), secret rotation, individual audit trails, and to avoid
exposing a full storage account key.

• Alternative: Storage Shared Key
Add: ebx.addon.dama.azure.storageAccountKey=<storageAccountKey>
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See also  Retrieving the Storage Account Key [p 80]

Attention
Shared key grants full access. Prefer Entra ID unless migration or temporary fallback is
required.

Note

If both Entra ID and a shared key are configured, Entra ID is used.

Note

A server restart may be required after changing these properties.

2. From the Administration panel, select: TIBCO EBX® Digital Asset Manager Add-on > Drive
> Drive.

3. Create a new record.

4. After adding a label and description, use the Connector menu to select Azure Blob.
Fill in the required fields. If you have questions about one of the properties, hover your mouse
over it and select the '?' to view its tooltip.
Please note that:

• The Storage account name is validated to ensure input is valid, but the name you enter must
match your Azure account information.

• The Container can be selected from existing folders, or you can click Create to add a new
folder.

5. After saving and closing, you must create a D.A.C. [p 23] to connect the Drive to a data model field.

18.3 Retrieving Microsoft Entra ID values
Use the Microsoft Azure Portal to obtain the following identifiers required for Entra ID authentication:

• Tenant ID

• Client (Application) ID

• Client Secret (or certificate)

Retrieval through Azure Portal
The Microsoft Azure Portal UI can change over time. If the following steps do not match what you
see, refer to the latest Microsoft Azure documentation.

1. Tenant ID: Navigate to Microsoft Entra ID > Overview and copy the Tenant ID.

2. Client ID: Go to Microsoft Entra ID > App registrations, select the application (service
principal), copy the Application (client) ID.

3. Client Secret: In the same application, open Certificates & secrets, create a new client secret,
copy its value immediately (it will be hidden later). Record expiration for rotation.
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4. Assign RBAC: Open the Storage Account, select Access control (IAM), add role assignment
(e.g. Storage Blob Data Contributor) to the application.

Validation
Be sure to confirm role propagation (this may take a few minutes).

18.4 Retrieving the Storage Account Key
The storage account key grants broad access to the account. Prefer Microsoft Entra ID whenever
possible. Use a key only for legacy scenarios or temporary fallback.

Retrieval through Azure portal
The Microsoft Azure Portal UI can change over time. If the following steps do not match what you
see, refer to the latest Microsoft Azure documentation.

1. In Azure Portal, go to Storage accounts and select your account.

2. Open Access keys (In the UI, this might display under Security + networking or Settings).

3. Click Show keys.

4. Copy either key1 or key2 value. Use only one key in the property:
ebx.addon.dama.azure.storageAccountKey=<storageAccountKey>.

5. Optional: Regenerate a key (only after confirming all dependent services are updated). Rotate
one key at a time to avoid outages.

Security considerations
When using a storage key, be aware of the following:

• Treat the key as a secret; never commit it to version control.

• Use key rotation and document last rotation date.

• Restrict distribution; prefer using service principals (Entra ID) for RBAC and audit trails.

• Remove the property when migrating to Entra ID to avoid unintended fallback.
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CHAPTER 19
Connecting to SharePoint

This chapter contains the following topics:

1. Concepts overview

2. Configuring a Drive and SharePoint connector

19.1 Concepts overview
Administrators can create a Drive that connects to a Microsoft Sharepoint storage location. This allows
you to attach assets to fields in EBX® while managing their storage outside of EBX®. Most add-
on features are available when using this type of Drive. However, some metadata such as labels,
descriptions, and tags can be added in EBX® but are not propagated to SharePoint.
Setup requires updating EBX® configuration properties in addition to add-on configuration tasks. The
following section provides the steps to complete these tasks.

Attention
Some steps require access to the server where EBX® is running and others require administrative
access to add-on configuration settings.

19.2 Configuring a Drive and SharePoint connector
To configure a Drive to use a SharePoint connector:

1. Add the following properties to your ebx.properties file:

• ebx.addon.dama.sharepoint.client.id=<YourClientId>

• ebx.addon.dama.sharepoint.secret.id=<YourSecretId>

• ebx.addon.dama.sharepoint.tenant.id=<YourTenantId>

Note

You might be required to stop and restart your server to complete this step.

2. From the Administration panel, select: TIBCO EBX® Digital Asset Manager Add-on > Drive
> Drive.

3. Create a new record.
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4. After adding a label and description, use the Connector menu to select SharePoint.
Fill in the required fields. If you have questions about one of the properties, hover your mouse
over it and select the '?' to view its tooltip.

5. After saving and closing, you must create a D.A.C. [p 23] to connect the Drive to a data model field.
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CHAPTER 20
Connecting to Google Drive

This chapter contains the following topics:

1. Concepts overview

2. Configuring a Drive and Google Drive connector

20.1 Concepts overview
Administrators can create a Drive that connects to a Google Drive storage location. This allows you to
attach assets to fields in EBX® while managing their storage outside of EBX®. Most add-on features
are available when using this type of Drive. However, some metadata such as labels, descriptions, and
tags can be added in EBX® but are not propagated to Google Drive.
Setup requires updating EBX® configuration properties in addition to add-on configuration tasks. The
following section provides the steps to complete these tasks.

Attention
Some steps require access to the server where EBX® is running and others require administrative
access to add-on configuration settings.

20.2 Configuring a Drive and Google Drive connector
To configure a Drive to use a Google Drive connector:

1. Point to your Google Drive credentials file location by adding the following property to your
ebx.properties file: ebx.addon.dama.google.credentials.file=<path _to_json_file>.

Note

You might be required to stop and restart your server to complete this step.

2. From the Administration panel, select: TIBCO EBX® Digital Asset Manager Add-on > Drive
> Drive.

3. Create a new record.

4. After adding a label and description, use the Connector menu to select Google Drive.
Fill in the required fields. If you have questions about one of the properties, hover your mouse
over it and select the '?' to view its tooltip.
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5. After saving and closing, you must create a D.A.C. [p 23] to connect the Drive to a data model field.
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CHAPTER 21
Performing bulk actions

This chapter contains the following topics:

1. Overview

2. Bulk upload

3. Attaching assets with batch processing

21.1 Overview
Uploading and attaching assets with the add-on's Upload and Attach services works well when you
have a limited number of assets because:

• You are limited to uploading 300 assets at one time.

• You need to open each record to attach assets.

To save time and effort when you are working with a large number of assets, you can perform a bulk
upload of zipped assets and then optionally attach assets automatically with batch processing. The
following sections cover these topics:

• Bulk upload [p 85]

• Attaching assets with batch processing [p 86]

Attention
To perform a bulk upload of assets, you must have access to the Administration panel. Additionally,
to automatically attach assets, you must have access to the most recent version of the EBX® Data
Exchange Add-on (New).

21.2 Bulk upload
To perform a bulk upload:

1. Navigate to Administration > User interface > TIBCO EBX® Digital Asset Manager Add-on >
Digital asset and selecting the Digital asset table.

2. Open the Actions menu and select the Import from a ZIP file service.

3. Fill in the required fields:

• Browse to select the desired file.
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• Specify the upload location using the Drive menu.

• Set the action to take if existing folders are encountered: keep the existing, and the imported
folders; replace the existing folders with the imported folders. Note this option is only
available when importing to a Drive managed by EBX®.

4. After clicking Import, the add-on keeps you apprised of its progress and displays a result page
upon successful completion.

5. From the Result page's Actions menu (shown below), you can export a report of the results, or
select multiple records to compare. Also, if the import fails, you can download a copy of the log
file.

21.3 Attaching assets with batch processing
The EBX® Data Exchange Add-on (New) can automatically attach assets using the CSV or Excel
import services. When performing the import, you use the Digital asset UUID lookup transformation
function in the Mapping screen.
Pre-requisites:

• A working EBX Digital Asset Manager Add-on configuration, including Drive and D.A.C., that
links the Drive to the table location where you want to attach assets.



Documentation > User Guide > Performing bulk actions

TIBCO EBX® Digital Asset Manager Add-on 87

• The Drive linked to the table must already contain the assets you want to attach.

• The latest version of the EBX® Data Exchange Add-on (New)

• A CSV or Excel file to map record primary keys and physical file names of assets. This file
specifies where to attach assets and must include the following:

• Columns that correspond to the primary key and Media-type fields of the records that you
want to attach assets to. For example, in the following image the first column is the table's
PK and the second is the media-type field.

• The fields in the Media-type column must contain a list of the file names of assets already
uploaded to a Drive. Only exact names are valid and must include the file extension. Use
the list separator defined in the EBX® Data Exchange Add-on to distinguish between file
names in the list.

Attention
To obtain a CSV or Excel file with all primary keys and the columns ready for assets, you can perform
an export with only the PK and media-type fields mapped.

The following instructions describe how to export a file containing the primary keys and
corresponding asset file names, and then use an import operation to automatically attach assets. If you
already have a file with primary keys and file names mapped, skip to Step 2.

1. Export primary key and Media-type fields:

1. Navigate to the table where assets are already attached to fields.

2. From the table's Actions menu, select Data Exchange (New) > Export CSV or Export Excel.

3. Select Mapping.

4. Delete all mappings, except for the primary key field. You can optionally delete all fields in
the target table, except for the primary key and Media-type fields.

5. From the list Transformation functions, under Cross reference, drag the Digital asset
name lookup function to the mapping area.

6. In the source table on the left, expand the Media-type field, and drag its connection point to
the input of the transformation function.

7. Connect the output of the transformation function to the corresponding field in the target
table.

8. Click Export and save the file.

2. Import generated the file to automatically attach assets:

1. Navigate to the table where you want to import assets.

2. From the table's Actions menu, select Data Exchange (New) > Import CSV or Import Excel.

3. Use the Source option to select the file containing the primary keys and lists of assets.
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4. Select Mapping.

5. Apply the Digital asset UUID lookup transformation function:
Note that if a mapping was automatically generated, you must delete it before completing
the following steps.

1. From the list Transformation functions, under Cross reference, drag the Digital asset
UUID lookup function to the mapping area.

2. In the source table on the left, drag the connection point from the field containing the list
of assets to the input (left side) of the transformation function.

3. Connect the output of the transformation function to the Media-type field in the target
table.

6. Select Import.
If an error occurs for individual records or assets, the import will continue with the other
records and assets. Any errors that occur display on the import result screen.
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CHAPTER 22
Displaying images in EBX® Tile view

This chapter contains the following topics:

1. Overview

22.1 Overview
You can create a tile view in EBX® that displays a field's digital asset (only image file types are
supported). In the data model, you must ensure that the media type field is a group containing a single
field with its Maximum number of values property is set to 1.
To create a tile view:

1. Open the table you want to create the view for, select View > Create a new view.

2. For the View mode select Tile view, fill in any other desired information, and click Next at the
bottom of the screen.

3. Enter the view's required title and click the icon next to the Image field.

4. Click the wand icon to set the Default image URL or URL and select Media type from the menu.
A suggested configuration might be to set the URL field to display attached images and to set
the Default image URL to a static resource. This setup will display a default image whenever a
media type field doesn't have an attached asset or the attachment can't be found.

5. After making any desired changes to the other settings, select Create and apply at the bottom
of the screen.
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CHAPTER 23
Mapping CJK Fonts

This chapter contains the following topics:

1. Overview

2. Configuration Steps

23.1 Overview
To ensure correct handling of multilingual Chinese, Japanese, and Korean (CJK) characters, create a
CJK font mapping file and reference it in your ebx.properties file.

Attention
The JSON file used for the mapping must be saved using UTF-8 encoding to correctly handle
multilingual CJK characters.

23.2 Configuration Steps
To create a mapping file referenced by ebx.properties:

1. Use the ebx.addon.dama.cjk.font.mapping.file.path to set the path to the CJK font mapping
JSON file in your ebx.properties file. Use an absolute or relative path. For example:
ebx.addon.dama.cjk.font.mapping.file.path=C:\fonts\cjk-font-mapping.json

2. Create the JSON font mapping file. This file must contain an array of objects, where each object
defines a CJK font mapping.
Example of the JSON structure:
[
  {
    "fontName": "Yu Mincho",
    "cjkName": "###",
    "path": "C:\\fonts\\yumin.ttf"
  },
  {
    "fontName": "Noto Sans CJK JP",
    "cjkName": "#######",
    "path": "/opt/fonts/NotoSansCJKjp.otf"
  },
  {
    "fontName": "Malgun Gothic",
    "cjkName": "## ##",
    "path": "C:\\fonts\\malgun.ttf"
  }
]
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See below for descriptions of the JSON object properties [p 92].

3. Ensure the following conditions are met for the font files:

• The font file specified in the path property exists locally and is readable by the TIBCO EBX®
Digital Asset Manager Add-on.

• File permissions allow the Add-on to access the font file. On Windows, ensure no other
process is locking the file.

• The following font file types are supported: .ttf and .otf.

4. Validate the JSON file for correct syntax and encoding. If the file is missing, unreadable, or
invalid, errors will be logged and the font mapping will not be applied.

Object property Descriptions
The following properties are used within each object in the JSON array:

• fontName The English name of the font.

• cjkName The corresponding Chinese, Japanese, or Korean font name. Mixed scripts are
supported.

• path The absolute or relative path to the font file on the local file system.
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CHAPTER 24
Migrating to version 6

Use the following steps to migrate the add-on from a version that is compatible with EBX® 5.9.X
to a version compatible with 6:

1. In the environment containing the old version of the add-on, navigate to Administration > User
interface > TIBCO EBX® Digital Asset Manager Add-on.

2. From the Actions menu, select Archives > Export.

3. In the environment containing the new version of the add-on, navigate to Administration > User
interface > TIBCO EBX® Digital Asset Manager Add-on.

4. From the Actions menu, select Archives > Export.
Note that since there is not a direct mapping of all properties from version 5 to 6, some tables will
have errors. Complete the following step to resolve these errors.

5. From the Actions menu, select Migrate digital asset manager data.

The following lists some of the terminology changes take place between versions 5 and 6 (other
changes are very minor):

• Drive type --> Connector

• File system --> Default connector

• External management --> External manager

• Display configuration --> Record detail view

• Editor configuration --> Drive view configuration
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CHAPTER 25
REST overview

This chapter contains the following topics:

1. Introduction

2. Special character encoding

3. Generating the OpenAPI Specification

25.1 Introduction
The TIBCO EBX® Digital Asset Manager Add-on allows access to its services using a RESTful API.
The add-on follows the OpenAPI Specification (OAS) to document its REST API. This allows you to
use tools such as Swagger to generate and interact with our REST documentation. It is not our intent
to document how to use these tools here. However, the following example shows one of the more
basic ways to view the REST API documentation.

25.2 Special character encoding
The add-on uses custom rules where special characters in primary keys or field names must be encoded
in the REST call. Instead of beginning the encoding with the % symbol, it must use an _. For example:

• A | character is encoded as _7C

• A _ character is encoded as _5F

• A / character is encoded as _2F

25.3 Generating the OpenAPI Specification
To generate the add-on's OAS:

1. Use a tool such as Postman to send a GET request to one of the following endpoints on your
EBX® server:

Note

Your EBX® log in credentials are also required to access the following endpoints
and can be entered in your REST client. For example, via Postman's Authorization
tab.

• http://<host>:<port>/ebx-addon-dama/rest/v1
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• http://<host>:<port>/ebx-addon-dama/rest/v2 This version includes endpoints that
support searching for assets using multiple types and extensions and criteria matching.

• http://<host>:<port>/ebx-addon-dama/rest/v3 This version includes endpoints that
support searching for assets in folder.

2. Ensure the response is formatted in JSON.

3. Save the response to a file.

4. Open a web browser and navigate to Swagger Editor: https://editor.swagger.io/.

5. Select File > Import file to import the add-on's specification.
The editor displays the formatted text on the left and HTML on the right.



Documentation > Developer Guide > REST overview

TIBCO EBX® Digital Asset Manager Add-on 98



Documentation > Developer Guide > REST service operations (deprecated)

TIBCO EBX® Digital Asset Manager Add-on 99

CHAPTER 26
REST service operations

(deprecated)
This chapter contains the following topics:

1. Overview

26.1 Overview
The TIBCO EBX® Digital Asset Manager Add-on provides features that allow you to use REST
services to get asset information. Responses are returned in the JSON format shown below where
status indicates completion success, message returns any messages, and data is the response data if
successful and null otherwise:
{
    "status": "success",
    "message": "Get success",
    "data": { }
}

See the following sections for details and examples:

• Retrieve an asset's URL [p 100]

• Get all registered mediaType fields [p 101]

• Getting media type field attachment info [p 102]

• Getting all assets in a Drive [p 103]

• Attach assets to a record [p 104]

• Detach assets from a record [p 105]

• Upload an asset from a record [p 106]
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Retrieve an asset's URL
The following table provides an example of asset URL retrieval:

Note

This REST operation was deprecated in the TIBCO EBX® Digital Asset Manager Add-
on 2.0.0 release.

Request URL http://<host>[:<port>]/ebx-addon-dama/rest-service/getAssetInformation?
assetUUID=<anAssetPrimaryKey>

Request parameters anAssetPrimaryKey: The asset's primary key.

Sample response
{
    "status": "success",
    "message": "Get success",
    "data": {
        "uuid": "A3CE402E-0A27-4151-9093-49366491892E",
        "name": {
            "locale": "en_US",
            "label": "asset_01.PNG",
            "description": ""
        },
        "preview_url": "http://<host>[:<port>]/ebx-addon-dama/AssetProvider?
assetPath=A3C...892E&versionId=B8D...A9B"

        "&height=150&width=150&original=true&uuid=fa6...0ca&moduleName=ebx-
addon-dama&contentId=B8D...A9B",

        "URL": "http://<host>[:<port>]/ebx-addon-dama/AssetProvider?
assetPath=A3C...892E&versionId=B8D...A9B"

        "&uuid=fa6...0ca&moduleName=ebx-addon-
dama&contentId=B8D...A9B&download=true",

        "defaultIcon": "http://<host>[:<port>]/ebx-addon-dama/AssetProvider?
assetPath=B7R...656V&versionId=SFA...A4T"

        "&uuid=fa6...0ca&moduleName=ebx-addon-dama&contentId=SFA...A4T",

        "creation_date": "01/01/2019 17:08:33",

        "last_updated_date": "01/01/2019 17:08:33",

        "versions": [

            {

                "uuid_version": "B8DCB43A-55C0-4968-9635-84EA9C5FEA9B",

                "version_name": "",

                "comment": "",

                "preview_url": "http://<host>[:<port>]/ebx-addon-dama/
AssetProvider?assetPath=A3C...892E&versionId=B8D...A9B"

               
 "&height=150&width=150&original=true&uuid=fa6...0ca&moduleName=ebx-addon-
dama&contentId=B8D...A9B",

                "URL": "http://<host>[:<port>]/ebx-addon-dama/AssetProvider?
assetPath=A3C...892E&versionId=B8D...A9B"

                "&uuid=fa6...0ca&moduleName=ebx-addon-
dama&contentId=B8D...A9B&download=true",

            }

        ],
        "metadata": []
    }
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}

Response parameters uuid: The asset's primary key.

name: The label and description based on the request header language (defaults to EN).

URL: The asset's URL.

creation_date: The asset's creation date.

last_update_date: The asset's most recent update date.

versions: The asset's version information.

metadata: All of the assets' metadata values.

preview_url: The URL of the asset preview.

defaulticon: The URL of the default file extension icon.

Note When using the addon-Token mechanism, the URL stays live for 30 minutes after the initial call.
In other cases the URL is authenticated by TIBCO EBX®. (HTTP Request, or login/password)

Get all registered mediaType fields
The example in the following table shows retrieval of all mediaType fields registered in the EBX
Digital Asset Manager Add-on:

Note

This REST operation was deprecated in the TIBCO EBX® Digital Asset Manager Add-
on 2.0.0 release.

Request URL http://<host>[:<port>]/ebx-addon-dama/rest-service/getMediaFields/
<dataspaceKey>/<datasetName>?tablePath=<aTablePath>

Request parameters dataspaceKey: An encoded dataspace key of the user's dataspace.

datasetName: An encoded dataset name of the user's dataset.

aTablePath: An encoded table path in the schema to get all media fields.

Sample response {
    "status": "success",
    "message": "Get success",
    "data": [
        {
            "fieldPath": "/fieldComplexCase/Group1/Group2/media",
            "dacCode":
 "_root_TestComplexCase_fieldComplexCase_Group1_Group2_media",
            "message": ""
        },
        {
            "fieldPath": "/fieldComplexCase2/group1/media1",
            "dacCode": "_root_TestComplexCase_fieldComplexCase2_group1_media1",
            "message": ""
        }
    ]
}

Response parameters fieldPath: The mediaType field's path in the adaptation.

dacCode: The dacCode registered in the mediaType field's D.A.C.

message: The message returned when the mediaType field isn't registered in the D.A.C.



Documentation > Developer Guide > REST service operations (deprecated)

TIBCO EBX® Digital Asset Manager Add-on 102

Getting media type field attachment info
The following table contains an example of getting information for assets attached to a mediaType
field:

Note

This REST operation was deprecated in the TIBCO EBX® Digital Asset Manager Add-
on 2.0.0 release.

Request URL http://<host>[:<port>]/ebx-addon-dama/rest-service/getAttachedAssetsInformation/
<dataspaceKey>/<datasetName>?tablePath=<aTablePath>
&primaryKey=<aPrimaryKey>&fieldPath=<aFieldPath>&useAddonToken=<useAddonToken>
&pageSize=<aPageSize>&pageIndex=<aPageIndex>

Request parameters dataspaceKey: An encoded dataspace key of the user dataspace.

datasetName: An encoded dataset name of the user dataset.

aTablePath: An encoded table path (in the schema).

aPrimaryKey: The current record's primary key.

aFieldPath: An encoded field path (in the adaptation).

useAddonToken: (optional) Determines whether the asset token will contain the add-on token.
Defaults to false.

aPageSize: (optional) Number of assets per page. Defaults to 10.

aPageIndex: (optional) The page index. Defaults to 1.

Sample response {
 "fieldPath": "/fieldSimpleCase",
 "viewMode": "mosaic_view",
 "permissions": {
     "change_current_version": true,
     "delete": true,
     "detach": true,
     "edit": true,
     "share_and_download": true,
     "upload": true,
     "upload_new_version": true,
     "view_digital_asset_of_other_user": true
 },
 "count": 10,
 "assetsInfo": [
     {
         "asset_status": 0,
         "asset_status_message": "",
         "uuid": "3896DE7A-BEC8-4E2A-BF2F-BC41790CF349",
         "name": {
             "locale": "en_US",
             "label": "asset_01.png",
             "description": ""
         },
         "URL": "http://<host>[:<port>]/ebx-addon-dama/AssetProvider?
assetPath=389...349&versionId=523...000",
         "defaultIcon": "",
         "creation_date": "1512456124962",
         "last_updated_date": "1512456124971",
         "mimeType": "png",
         "fileSize": "0.1",
         "metadata": []
     }
 ]
}

Response parameters viewMode: The configuration view mode (mosaic view/ list view).

permissions: The permissions on the D.A.C.

count: The number of assets attached to the field.
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assetInfo: The attached asset information.

Getting all assets in a Drive
The following table contains an example of getting all assets in a Drive:

Note

This REST operation was deprecated in the TIBCO EBX® Digital Asset Manager Add-
on 2.0.0 release.

Request URL http://<host>[:<port>]/ebx-addon-dama/rest-service/getAllAssets/<dataspaceKey>/
<datasetName>?tablePath=<aTablePath>
&fieldPath=<aFieldPath>&useAddonToken=<useAddonToken>&pageSize=<aPageSize>
&pageIndex=<aPageIndex>

Request parameters dataspaceKey: An encoded dataspace key of the user dataspace.

datasetName: An encoded dataset name of the user dataset.

aTablePath: An encoded table path (in the schema).

aFieldPath: An encoded field path (in the adaptation).

useAddonToken: (optional) Determines whether the asset token will contain the add-on token.
Defaults to false.

aPageSize: (optional) Number of assets per page. Defaults to 10.

aPageIndex: (optional) The page index. Defaults to 1.

Sample response {
 "asset_status": 0,
 "asset_status_message": "",
 "uuid": "110...741",
 "name": {
  "locale": "en_US",
  "label": "asset_01.jpg",
  "description": ""
 },
 "URL": "http://<host>[:<port>]/ebx-addon-dama/AssetProvider?
assetPath=110...741&versionId=5BB...15A",
 "defaultIcon": "",
 "creation_date": "1519617088917",
 "last_updated_date": "1519627827201",
 "mimeType": "jpg",
 "fileSize": "0.2",
 "metadata": [],
 "attached" : true
}
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Attach assets to a record
The following table contains an example of attaching assets to a record:

Attention
This REST operation has been deprecated in the EBX Digital Asset Manager Add-on 1.5.0 release.

Method type: POST

Request URL http://<host>[:<port>]/ebx-addon-dama/rest-service/attachAssets/<dataspaceKey>/
<datasetName>

Request parameters dataspaceKey: An encoded dataspace key of the user dataspace.

datasetName: An encoded dataset name of the user dataset.

Request body Content-type: application/x-www-form-urlencoded

Parameters:

aTablePath: An encoded table path (in the schema).

aFieldPath: An encoded field path (in the adaptation).

primaryKey: The current record's primary key.

uuids: The UUIDs of assets to attach.

overwrite: (optional) If true, existing assets are replaced. If false, new assets are attached
alongside existing assets. Defaults to false if undefined.

Sample responses If one attachment fails when attaching multiple assets, no assets will be attached and an error
message is returned.

If successful:

{
 "status": "success"
}

If unsuccessful (all message content will follow the request locale):

{
 "status": "unsuccess",
 "message": {
  "type": "error",
  "code": "1",
  "messageContent": "has error ..."
 }
}
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Detach assets from a record
The following table contains an example of detaching assets from a record:

Attention
This REST operation has been deprecated in the EBX Digital Asset Manager Add-on 1.5.0 release.

Method type: POST

Request URL http://<host>[:<port>]/ebx-addon-dama/rest-service/detachAssets/<dataspaceKey>/
<datasetName>

Request parameters dataspaceKey: An encoded dataspace key of the user dataspace.

datasetName: An encoded dataset name of the user dataset.

Request body Content-type: application/x-www-form-urlencoded

Parameters:

aTablePath: An encoded table path (in the schema).

aFieldPath: An encoded field path (in the adaptation).

primaryKey: The current record's primary key.

uuids: The UUIDs of assets to attach.

detachAll: (optional) If true, all assets attached to a media field will be detached. You do
not need to provide asset UUIDs in this case. If false, only assets identified by the UUIDs are
detached. Defaults to false if undefined.

Sample responses If successful:

{
 "status": "success"
}

If unsuccessful (all message content will follow the request locale):

{
 "status": "unsuccess",
 "message": {
  "type": "error",
  "code": "1",
  "messageContent": "has error ..."
 }
}
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Upload an asset from a record
The following table provides an example of uploading an asset via REST:

Note

This REST operation was deprecated in the TIBCO EBX® Digital Asset Manager Add-
on 2.0.0 release.

Method type POST

URL http://<host>[:<port>]/ebx-addon-dama/rest/asset/v1/<dataspaceKey>/
<datasetName>:upload?
tablePath=<aTablePath>&fieldPath=<aFieldPath>&primaryKey=<primaryKey>

Parameters dataspaceKey: An encoded dataspace key of the user dataspace.

datasetName: An encoded dataset name of the user dataset.

aTablePath: An encoded table path (in the schema).

aFieldPath: An encoded field path (in the adaptation).

primaryKey: The record's primary key.

Request headers Authorization: The EBX®'s authorization key.

Content-Type: application/x-www-form-urlencoded

Request body file: The binary file (required).

name: The asset's name (required).

tags: (optional) The assets' tags. This is an array of tags, separated by comma. Example: "tag1,
tag2, tag3".

attach: (optional) If true, the asset will be uploaded and attached into record. Otherwise, it will
be uploaded without being attached.

Sample response {
    "URL": "http://<host>[:<port>]/ebx-addon-dama/AssetProvider?
assetPath=520...D61&versionId=FB3...8C2",
    "asset_status": "0",
    "asset_status_message": "",
    "creation_date": "01/01/2019 10:54:14",
    "fileSize": "0.2",
    "last_update_date": "01/01/2019 10:54:14",
    "logicalName": "asset_01.png",
    "metaData": [],
    "mimeType": "png",
    "name": {
        "label": "asset_01",
        "locale": "en"
    },
    "tags": [
        "tag1",
        "tag2",
        "tag3"
    ],
    "uuid": "520A6F13-60B0-4EAA-901E-A1D28D677D61",
    "versionId": "FB34C7B4-1595-47FD-BAA9-B14387DB98C2"
}

Response parameters URL: The asset's URL.

asset_status: The asset's status.

asset_status_message: The asset's status message.

creation_date: The asset's creation date.
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fileSize: The asset's creation date.

last_update_date: The asset's most recent update date.

logicalName: The asset's logical name.

metadata: The assets' metadata values.

mimeType: The asset's mime type.

name: The asset's name.

tags: The assets' tags values.

uuid: The asset's primary key.

versions: The asset's version information.
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CHAPTER 27
Setting the URL expiration for assets

When you use the REST or Java API to get an asset's URL, that token is only valid for a set
amount of time. You can specify the time limit in the ebx.properties file by changing the value of
ebx.addon.dama.rest.token.timeout. This property defaults to a value of 1800 seconds (30 minutes).
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storage locations
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CHAPTER 28
Connecting to alternative storage

locations
This chapter contains the following topics:

1. Overview

2. High-level flow

3. Implementing registration and definition classes

28.1 Overview
The add-on's API allows you to access alternative asset storage locations. An "alternative" storage
location could be one which requires credentials and a third-party API to access. For example, assets
might be stored in the cloud on Google Drive or AWS. Alternatively, you may already use a third-
party tool to manage digital assets but, you want to enable data model access to these assets. Since
these types of locations and use cases require management outside of EBX®, we refer to these as
externally managed storage locations.
The headings below outline high-level implementation steps. See Example Implementation [p 115]

for an example implementation.

28.2 High-level flow
Several steps are require to implement access to an externally managed storage location. Those in a
developer role perform most steps; as noted below, EBX® administrators complete others:

• Implement the following:

• A class that provides add-on functionality for external storage locations. This class can also
specify asset tags and search functionality.

• A definition of the class that implements the add-on's API. EBX® must register this definition
class on repository startup or from a user-run service.

• Any classes required by third-party tools. For example, helper classes that contain connection
credential and error handling information.

• Ensure that any required libraries are deployed in the same location as your ebx.jar file. This
would include any JAR files containing your classes that implement the add-on's API. See the
EBX® Development Guide for more information on deployment requirements.
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• Steps an EBX® administrator must complete in the UI:

• If required, run the service that registers the external storage management class.

• Create an add-on Drive and configure it to use external storage. Ensure proper settings for
user permissions.

• Create a D.A.C. to link the data model field and Drive. Ensure proper settings for user
permissions.

For instructions, see Configuring an external Drive [p 73].

28.3 Implementing registration and definition classes
The following sections describe how to implement:

• Custom Connectors

• External Manager Connectors

Custom Connectors
As shown below, the class you write to specify Drive options for an externally managed location must
extend the StorageManager abstract class. The methods in this class enable operations on assets stored
in an external location.
import com.orchestranetworks.addon.dama.common.util.*;
import com.orchestranetworks.addon.dama.ext.*;
import com.orchestranetworks.addon.dama.ext.bean.*;
import com.orchestranetworks.addon.dama.ext.exception.*;
import com.orchestranetworks.addon.dama.ext.resource.*;
import com.orchestranetworks.addon.dama.i18n.*;
   
public class ExternalStorageManager extends StorageManager
{
    // TODO populate with required methods.
    public ResourceIdentifier upload(Resource resource, ResourceIdentifier target) throws DAMException
   {
    ...
   }
}

The below definition class which extends the add-on's ConnectorManagerDefinition can be used to
register your external management class. Note that in this class you can also determine whether users
can upload assets to the external storage location from the add-on's Drive view.
import com.orchestranetworks.addon.dama.ext.*;
import com.orchestranetworks.addon.dama.externalmanagement.search.*;;
import com.orchestranetworks.addon.dama.i18n.*;
   
public class ExternalConnectorManagerDefinition extends ConnectorManagerDefinition
{
    // TODO populate with required methods.
    public StorageManager getStorageManager()
   {
    return new ExternalStorageManager();
   }
}

To make your Custom Connector storage location implementation available as an option in the UI,
it must be registered. You can register the external storage management upon EBX® startup, or by
implementing a service. For more information on module and service registration, see the EBX®
documentation. To register the external storage manager, add the following code to your registration
servlet or service dispatcher:
ConnectorManagerRegistry.registerConnector(new ExternalConnectorManagerDefinition());
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External Manager Connectors
As shown below, the class you write to specify Drive options for an externally managed location must
implement the ExternalManager interface. The methods in this interface enable operations on assets
stored in an external location.
import com.orchestranetworks.addon.dama.ext.exception.*;
import com.orchestranetworks.addon.dama.ext.resource.*;
import com.orchestranetworks.addon.dama.externalmanagement.*;
import com.orchestranetworks.addon.dama.externalmanagement.bean.*;
import com.orchestranetworks.addon.dama.externalmanagement.request.*;
import com.orchestranetworks.addon.dama.externalmanagement.response.*;
 
public class ExternalStorageDrive implements ExternalManager
{
 // TODO populate with required methods.
}

The below definition class which extends the add-on's ExternalManagerDefinition can be used to
register your external management class. Note that in this class you can also determine whether users
can upload assets to the external storage location from the add-on's Drive view.
import com.orchestranetworks.addon.dama.externalmanagement.*;

public final class ExternalStorageDriveDefinition extends ExternalManagerDefinition
{
 // Creates a new ExternalManager based on your implementation
 public ExternalManager getExternalManager()
 {
  return new ExternalStorageDrive();
 }
 
 // Determines whether upload to the external storage location is enabled
 public boolean allowUpload()
 {
  return true;
 }
}

To make your external storage location implementation available as an option in the UI, it must be
registered. You can register the external storage management upon EBX® startup, or by implementing
a service. For more information on module and service registration, see the EBX® documentation.
To register the external storage manager, add the following code to your registration servlet or service
dispatcher:
ExternalManagerCatalog.add(new ExternalStorageDriveDefinition());
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CHAPTER 29
Example Implementation

This chapter contains the following topics:

1. Overview

2. Sample external manager class

3. Sample definition class

4. Registering your manager class

5. Including third-party resources

29.1 Overview
This section provides a sample configuration by connecting to a Google Drive. Note these
requirements are specific to Google Drive at the time of publishing and your requirements will vary
depending on how you plan to implement the API.

29.2 Sample external manager class
As shown below, you can begin with a manager class that implements the ExternalManager interface.
The sample includes search functionality, asset display, and other features. Keep in mind that although
you can code most add-on features including download, upload and delete, administrators can still
define permissions on these actions when creating the Drive and D.A.C in the UI.

Attention
The samples below have several references to a helper class (not shown) that has been defined to
meet requirements specific to making Google Drive API calls. The contents of your helper class will
depend on implementation requirements.

The sections below provide the following samples:

• Class implementation [p 116]

• Search filter implementation [p 117]

• Asset creation [p 118]

• Asset deletion [p 118]

• Asset retrieval [p 118]
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• Asset tags [p 120]

Class implementation
import java.io.*;
import java.math.*;
import java.net.*;
import java.util.*;

import jakarta.activation.*;

import com.onwbp.base.text.bean.*;
import com.orchestranetworks.addon.dama.*;
import com.orchestranetworks.addon.dama.common.*;
import com.orchestranetworks.addon.dama.ext.bean.*;
import com.orchestranetworks.addon.dama.ext.exception.*;
import com.orchestranetworks.addon.dama.ext.exception.DAMException;
import com.orchestranetworks.addon.dama.ext.resource.*;
import com.orchestranetworks.addon.dama.externalmanagement.*;
import com.orchestranetworks.addon.dama.externalmanagement.bean.*;
import com.orchestranetworks.addon.dama.externalmanagement.request.*;
import com.orchestranetworks.addon.dama.externalmanagement.response.*;
import com.orchestranetworks.addon.dama.models.*;
import com.orchestranetworks.addon.utils.*;

/**
 */
public class ExternalGoogleManager implements ExternalManager
{
 //Instance variable to access the helper class for the Google Drive
 private final Drive googleDrive;

 public ExternalGoogleManager()
 {
  try
  {
   this.googleDrive = GoogleDriveAPIHelper.getInstance().getDriveService();
  }
  catch (Exception ex)
  {
   throw new RuntimeException(ex);
  }
 }
 
 //Sample method used to pass asset URL information to other methods
 private String getUrl(String externalId, String fileName, String extension, boolean isDownload)
  throws UnsupportedEncodingException
 {
  //The network location where EBX is running
  String host = "localhost:8080";

  String providerLink = "http://" + host
   + "/<your module name>/<your service dispatcher>?service=<your service name>";
  StringBuilder urlDownload = new StringBuilder(providerLink);
  urlDownload.append("&external_id=").append(URLEncoder.encode(externalId, "UTF-8"));
  urlDownload.append("&fileName=")
   .append(URLEncoder.encode(this.getFileName(fileName, extension), "UTF-8"));
  urlDownload.append("&extension=").append(extension);
  if (isDownload)
  {
   urlDownload.append("&download=").append(Boolean.TRUE.toString());
  }

  return urlDownload.toString();
 }

 private LabelDescription getLabelDescription(String name, List<Locale> locales)
 {
  if (AddonStringUtils.isEmpty(name))
  {
   name = DAMConstants.EMPTY_STRING;
  }

  List<LabelDescriptionForLocale> labelDescriptionForLocales = new ArrayList<>();
  for (Locale locale : locales)
  {
   LabelDescriptionForLocale labelDesLocale = new LabelDescriptionForLocale();
   labelDesLocale.setLocale(locale);
   labelDesLocale.setLabel(name);
   labelDesLocale.setDescription(name);
   labelDescriptionForLocales.add(labelDesLocale);
  }
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  LabelDescription labelDescription = new LabelDescription();
  labelDescription.setLocalizedDocumentations(labelDescriptionForLocales);

  return labelDescription;
 }
}

Search filter implementation
public ExternalSearchAssetsResult searchAssets(ExternalSearchRequest searchRequest)
{
 ExternalSearchAssetsResult result = new ExternalSearchAssetsResult();
 SearchFilter searchFilter = searchRequest.getSearchFilter();
 String keyword = (searchFilter == null) ? DAMConstants.EMPTY_STRING
  : searchFilter.getKeyword();
 try
 {
  FileList fileList = this.googleDrive.files().list().setFields("*").execute();
  List<File> allFiles = fileList.getFiles();
  List<File> filteredFiles = new ArrayList<>();

  for (File file : allFiles)
  {
   if (AddonStringUtils.isEmpty(keyword))
   {
    filteredFiles.add(file);
   }
   else
   {
    if (file.getName().contains(keyword)
     || file.getOriginalFilename().contains(keyword))
    {
     filteredFiles.add(file);
    }
   }
  }
  int size = filteredFiles.size();
  int pageIndex = (searchRequest.getPageIndex() < 1) ? 1 : searchRequest.getPageIndex();
  int pageSize = (searchRequest.getPageSize() < 10) ? 10 : searchRequest.getPageSize();
  int startIndex = (pageIndex - 1) * pageSize;
  int endIndex = startIndex + pageSize - 1;
  if (endIndex > size - 1)
  {
   endIndex = size - 1;
  }

  List<ExternalDigitalAsset> externalAssets = new ArrayList<>();
  for (int i = startIndex; i <= endIndex; i++)
  {
   File googleFile = filteredFiles.get(i);
   String downloadUrl = this.getUrl(
    googleFile.getId(),
    googleFile.getName(),
    googleFile.getFileExtension(),
    true);
   String previewUrl = this.getUrl(
    googleFile.getId(),
    googleFile.getName(),
    googleFile.getFileExtension(),
    false);
   ExternalDigitalAsset externalAsset = new ExternalDigitalAsset();
   externalAsset.setLabelDescription(
    this.getLabelDescription(
     googleFile.getName(),
     searchRequest.getHome().getRepository().getLocales()));
   externalAsset.setURL(previewUrl);
   externalAsset.setThumbnailURL(googleFile.getThumbnailLink());
   externalAsset.setDownloadURL(downloadUrl);
   externalAsset.setExtension(googleFile.getFileExtension());
   externalAsset.setAssetType(googleFile.getFileExtension());
   externalAsset.setId(googleFile.getId());
   externalAsset.setPhysicalName(googleFile.getName());
   externalAsset.setCreationDate(new Date(googleFile.getCreatedTime().getValue()));
   externalAsset.setLastUpdatedDate(new Date(googleFile.getModifiedTime().getValue()));
   externalAsset.setFileSize(new BigDecimal(googleFile.getSize().longValue()));
   Map<String, String> metaDataMap = new HashMap<>();
   metaDataMap.put("mKey1", "mValue1");
   metaDataMap.put("mKey2", "mValue2");
   externalAsset.setMetaDatas(metaDataMap);
   externalAsset.setWidth(new Integer(300));
   externalAsset.setHeight(new Integer(200));
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   externalAssets.add(externalAsset);
  }
        // Specifies the total digital assets of search results.
        result.setTotal(1000)
  result.setAssets(externalAssets);
 }
 catch (Exception ex)
 {
  throw new RuntimeException(ex);
 }

 return result;
}

Asset creation
public ExternalDigitalAsset createAsset(ExternalUploadAssetRequest request)
{
 ExternalDigitalAsset asset = new ExternalDigitalAsset();
 File googleFile = new File();
 FileResource fileResource = request.getFileResource();
 String fileName = fileResource.getFile().getName();
 googleFile.setName(fileName);
 FileContent mediaContent = new FileContent(
  new MimetypesFileTypeMap().getContentType(fileName),
  fileResource.getFile());
 try
 {
  File googleFileUploaded = this.googleDrive.files()
   .create(googleFile, mediaContent)
   .setFields("*")
   .execute();
  asset.setId(googleFileUploaded.getId());
  asset.setPhysicalName(googleFileUploaded.getOriginalFilename());
  asset.setThumbnailURL(googleFileUploaded.getThumbnailLink());
  asset.setLabelDescription(
   this.getLabelDescription(
    googleFileUploaded.getName(),
    request.getHome().getRepository().getLocales()));
 }
 catch (IOException ex)
 {
  throw new RuntimeException(ex);
 }

 return asset;
}

Asset deletion
public OperationExecutionStatus deleteAsset(
   ExternalSingularRequest request,
   boolean isPhysicalDelete)
{
 OperationExecutionStatus status = new OperationExecutionStatus();
 try
 {
  this.googleDrive.files().delete(request.getExternalId()).execute();
 }
 catch (IOException ex)
 {
  status = new OperationExecutionStatus(new DAMException(ex.getMessage()));
 }

 return status;
}

Asset retrieval
public ExternalDigitalAsset getAsset(ExternalSingularRequest request) throws DAMException
{
 ExternalDigitalAsset digitalAsset = new ExternalDigitalAsset();
 try
 {
  File file = this.googleDrive.files()
   .get(request.getExternalId())
   .setFields("*")
   .execute();
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  String urlDownload = this
   .getUrl(file.getId(), file.getName(), file.getFileExtension(), true);
  String previewUrl = this
   .getUrl(file.getId(), file.getName(), file.getFileExtension(), false);
  digitalAsset.setId(file.getId());
  digitalAsset.setPhysicalName(file.getOriginalFilename());
  digitalAsset.setLabelDescription(
   this.getLabelDescription(
    file.getName(),
    request.getHome().getRepository().getLocales()));
  digitalAsset.setURL(previewUrl);

  boolean isImage = DigitalAssetExtension.parseExtension(file.getFileExtension())
   .getDigitalAssetContentType()
   .isImage();
  if (isImage)
  {
   digitalAsset.setThumbnailURL((previewUrl));
  }
  else
  {
   digitalAsset.setThumbnailURL(file.getThumbnailLink());
  }
  digitalAsset.setDownloadURL(urlDownload);
  digitalAsset.setAssetType(file.getFileExtension());
  digitalAsset.setExtension(file.getFileExtension());
  digitalAsset.setCreationDate(new Date(file.getCreatedTime().getValue()));
  digitalAsset.setLastUpdatedDate(new Date(file.getModifiedTime().getValue()));
  digitalAsset.setFileSize(new BigDecimal(file.getSize().longValue()));
  Map<String, String> metaDataMap = new HashMap<>();
  metaDataMap.put("mKey1", "mValue1");
  metaDataMap.put("mKey2", "mValue2");
  digitalAsset.setMetaDatas(metaDataMap);
  digitalAsset.setWidth(new Integer(300));
  digitalAsset.setHeight(new Integer(200));
 }
 catch (IOException ex)
 {
  throw new DAMException(ex);
 }

 return digitalAsset;
}

public List<ExternalDigitalAsset> getAssets(ExternalPluralRequest externalRequest)
{
 List<ExternalDigitalAsset> externalAssets = new ArrayList<>();
 for (String externalId : externalRequest.getExternalIds())
 {
  try
  {
   File file;
   try
   {
    file = this.googleDrive.files().get(externalId).setFields("*").execute();
   }
   catch (Exception ex)
   {
    continue;
   }

   ExternalDigitalAsset externalDigitalAsset = new ExternalDigitalAsset();
   externalDigitalAsset.setId(file.getId());
   externalDigitalAsset.setPhysicalName(file.getOriginalFilename());
   externalDigitalAsset.setCreationDate(new Date(file.getCreatedTime().getValue()));
   externalDigitalAsset
    .setLastUpdatedDate(new Date(file.getModifiedTime().getValue()));
   externalDigitalAsset.setLabelDescription(
    this.getLabelDescription(
     file.getName(),
     externalRequest.getHome().getRepository().getLocales()));
   String urlDownload = this
    .getUrl(file.getId(), file.getName(), file.getFileExtension(), true);
   String previewUrl = this
    .getUrl(file.getId(), file.getName(), file.getFileExtension(), false);
   externalDigitalAsset.setURL(previewUrl);
   externalDigitalAsset.setThumbnailURL(file.getThumbnailLink());
   externalDigitalAsset.setWidth(new Integer(300));
   externalDigitalAsset.setHeight(new Integer(200));
   externalDigitalAsset.setDownloadURL(urlDownload);
   externalDigitalAsset.setAssetType(file.getFileExtension());
   externalDigitalAsset.setExtension(file.getFileExtension());

   Map<String, String> metaDatas = new HashMap<>();
   metaDatas.put("metadata1", "metadata1");
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   metaDatas.put("metadata2", "metadata2");
   externalDigitalAsset.setMetaDatas(metaDatas);

   externalDigitalAsset.setTags(Arrays.asList("tag1", "tag2"));

   externalAssets.add(externalDigitalAsset);
  }
  catch (IOException ex)
  {
   throw new RuntimeException(ex);
  }
 }

 return externalAssets;
}

Asset tags
public ExternalTagResult getTags(ExternalCommonRequest request)
{
 ExternalTagResult externalTagResult = new ExternalTagResult();

 Tag tag1 = new Tag();
 tag1.setCode("tag1");
 tag1.setFontSize("14");
 externalTagResult.getTags().add(tag1);

 Tag tag2 = new Tag();
 tag2.setCode("tag2");
 tag2.setFontSize("16");
 externalTagResult.getTags().add(tag2);

 return externalTagResult;
}

29.3 Sample definition class
The following code sample shows how to instantiate the class you implemented above. Additionally,
note that you can use the allowUpload() to determine whether users can upload to the external storage
location.
import com.orchestranetworks.addon.dama.externalmanagement.*;

public final class ExternalGoogleManagerDefinition extends ExternalManagerDefinition
{
 // Creates a new ExternalManager based on your implementation
 public ExternalManager getExternalManager()
 {
  return new ExternalGoogleManager();
 }
 
 // Determines whether upload to the external storage location is enabled
 public boolean allowUpload()
 {
  return true;
 }
}

29.4 Registering your manager class
You can register your custom class either on repository startup or by running a service in the UI. For
information on how to declare a module (for startup registration) or declare a user service, please see
the TIBCO EBX® Developer Guide.
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29.5 Including third-party resources
Any resources required by a third-party should be added to the same location as your ebx.jar file.
As shown below the required libraries for the Google Drive API are deployed in Tomcat along with
EBX®.
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CHAPTER 30
Add-on specific services

This chapter contains the following topics:

1. Overview of add-on specific services
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30.1 Overview of add-on specific services
The TIBCO EBX® Digital Asset Manager Add-on provides several custom services that allow you
to perform asset management-specific actions. To access these services open the Actions menu for
the specified dataset, or table. The following describes the location of each service and its scope:

Name/Location/Scope Description

TIBCO EBX® Digital Asset Manager Add-on dataset

The Migrate digital asset manager
data service applies to the dataset.

Migrates previous add-on versions to the latest version.

The Create D.A.C. for data model
service applies to the dataset.

Automatically creates a D.A.C. for a data model you specify. Before running the
service, ensure that the data model contains a 'media type' field.

The Manage digital assets service
applies to all assets in all Drives.

Allows you full control over any asset in any Drive.

The Backup service applies to the
dataset.

Creates a backup of your digital assets.

The Restore service applies to the
dataset.

Allows you to restore digital assets.

Drive table

The Delete all digital assets in selected
drive(s) service applies to selected
records.

Deletes all digital assets contained in the selected Drives.

Change physical root path Allows you to change the selected Drive's physical root path.

Digital asset table

Identify unused assets Locates any unused assets and filters the table display so that only those records
display. An unused asset is one that is not attached to a field.

Import from a ZIP file Allows you to perform a bulk import of assets from a ZIP file.

Export to a ZIP file Allows you to export a selection of assets to a ZIP file.

The Create new version service applies
to selected records.

Creates a new version of the selected asset.

The Upload new digital asset service
applies to the table.

Allows you to upload a new digital asset.

The Activate service applies to the
selected assets.

Allows you to active an asset from this screen.
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Name/Location/Scope Description

The Deactivate (Logical delete) service
applies to selected records.

Changes the selected asset's state to 'Deactivated'. You can return the asset to
'Activated', or another state by opening the asset and using the 'State' drop-down list.

The Permanently delete (Physical
delete) service applies to selected
records.

Physically removes the digital asset from the Drive.

Digital asset version table

The Create new version service applies
to the table.

Allows you to upload a new version of an asset.

The Delete digital asset version applies
to selected records.

Physically removes the digital asset version.
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CHAPTER 31
Documentation and Support

For information about this product, you can read the documentation, contact TIBCO Support, and
join TIBCO Community.
This chapter contains the following topics:

1. How to Access TIBCO Documentation

2. Product-Specific Documentation

3. How to Contact Support for TIBCO Products

4. How to Join TIBCO Community

31.1 How to Access TIBCO Documentation
Documentation for TIBCO products is available on the Product Documentation website website,
mainly in HTML and PDF formats.
The Product Documentation website website is updated frequently and is more current than any other
documentation included with the product.

31.2 Product-Specific Documentation
The documentation for the TIBCO EBX® is available on the TIBCO EBX® Product Documentation
page. This page contains the latest version of each document.
The documentation for the TIBCO EBX® Add-ons is available on the TIBCO EBX® Add-ons
Product Documentation page. This page contains the latest version of each document.
To view the documents for Add-on Bundles that are compatible with other versions of TIBCO EBX®,
use the Bundle version menu to select the desired release.

31.3 How to Contact Support for TIBCO Products
You can contact the Support team in the following ways:

• To access the Support Knowledge Base and getting personalized content about products you are
interested in, visit our product Support website.

• To create a Support case, you must have a valid maintenance or support contract with a Cloud
Software Group entity. You also need a username and password to log in to the product Support
website. If you do not have a username, you can request one by clicking Register on the website.

https://docs.tibco.com/
https://docs.tibco.com/
https://docs.tibco.com/products/tibco-ebx
https://docs.tibco.com/products/tibco-ebx-add-ons/
https://docs.tibco.com/products/tibco-ebx-add-ons/
{ebx.support.url}
{ebx.support.url}
{ebx.support.url}
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• To submit ideas, suggestions, or feedback for TIBCO products, visit our product Support website.

31.4 How to Join TIBCO Community
TIBCO Community is the official channel for TIBCO customers, partners, and employee subject
matter experts to share and access their collective experience. TIBCO Community offers access to
Q&A forums, product wikis, and best practices. It also offers access to extensions, adapters, solution
accelerators, and tools that extend and enable customers to gain full value from TIBCO products. In
addition, users can submit and vote on feature requests from within the TIBCO Ideas Portal. For a
free registration, go to TIBCO Community.

{ebx.support.url}
https://ebx.ideas.aha.io/
https://community.tibco.com
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CHAPTER 32
Legal and Third-Party

SOME CLOUD SOFTWARE GROUP, INC. (“CLOUD SG”) SOFTWARE AND CLOUD
SERVICES EMBED, BUNDLE, OR OTHERWISE INCLUDE OTHER SOFTWARE, INCLUDING
OTHER CLOUD SG SOFTWARE (COLLECTIVELY, “INCLUDED SOFTWARE”). USE OF
INCLUDED SOFTWARE IS SOLELY TO ENABLE THE FUNCTIONALITY (OR PROVIDE
LIMITED ADD-ON FUNCTIONALITY) OF THE LICENSED CLOUD SG SOFTWARE AND/
OR CLOUD SERVICES. THE INCLUDED SOFTWARE IS NOT LICENSED TO BE USED OR
ACCESSED BY ANY OTHER CLOUD SG SOFTWARE AND/OR CLOUD SERVICES OR FOR
ANY OTHER PURPOSE.
USE OF CLOUD SG SOFTWARE AND CLOUD SERVICES IS SUBJECT TO THE TERMS
AND CONDITIONS OF AN AGREEMENT FOUND IN EITHER A SEPARATELY EXECUTED
AGREEMENT, OR, IF THERE IS NO SUCH SEPARATE AGREEMENT, THE CLICKWRAP
END USER AGREEMENT WHICH IS DISPLAYED WHEN ACCESSING, DOWNLOADING,
OR INSTALLING THE SOFTWARE OR CLOUD SERVICES (AND WHICH IS DUPLICATED IN
THE LICENSE FILE) OR IF THERE IS NO SUCH LICENSE AGREEMENT OR CLICKWRAP
END USER AGREEMENT, THE LICENSE(S) LOCATED IN THE “LICENSE” FILE(S) OF
THE SOFTWARE. USE OF THIS DOCUMENT IS SUBJECT TO THOSE SAME TERMS AND
CONDITIONS, AND YOUR USE HEREOF SHALL CONSTITUTE ACCEPTANCE OF AND AN
AGREEMENT TO BE BOUND BY THE SAME.
This document is subject to U.S. and international copyright laws and treaties. No part of this document
may be reproduced in any form without the written authorization of Cloud Software Group, Inc.
TIBCO, the TIBCO logo, the TIBCO O logo, TIBCO EBX®, TIBCO EBX® Data Exchange Add-on,
TIBCO EBX® Add-on's Root Module, TIBCO EBX® Digital Asset Manager Add-on, TIBCO EBX®
Match and Merge Add-on, TIBCO EBX® Data Model and Data Visualization Add-on, TIBCO EBX®
Insight Add-on, TIBCO EBX® Graph View Add-on, TIBCO EBX® Add-on for Oracle Hyperion
EPM, TIBCO EBX® Information Governance Add-on, TIBCO EBX® GO Add-on, TIBCO EBX®
Activity Monitoring Add-on, TIBCO EBX® Rule Portfolio Add-on, and TIBCO EBX® Information
Search Add-on are either registered trademarks or trademarks of Cloud Software Group, Inc. in the
United States and/or other countries.
All other product and company names and marks mentioned in this document are the property of their
respective owners and are mentioned for identification purposes only. You acknowledge that all rights
to these third party marks are the exclusive property of their respective owners. Please refer to Cloud
SG’s Third Party Trademark Notices (https://www.cloud.com/legal) for more information.
This document includes fonts that are licensed under the SIL Open Font License, Version 1.1, which
is available at: https://scripts.sil.org/OFL.
Copyright (c) Paul D. Hunt, with Reserved Font Name Source Sans Pro and Source Code Pro.

https://www.cloud.com/legal
https://scripts.sil.org/OFL
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Cloud SG software may be available on multiple operating systems. However, not all operating system
platforms for a specific software version are released at the same time. See the “readme” file for the
availability of a specific version of Cloud SG software on a specific operating system platform.
THIS DOCUMENT IS PROVIDED “AS IS” WITHOUT WARRANTY OF ANY KIND,
EITHER EXPRESS OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED
WARRANTIES OF MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE, OR NON-
INFRINGEMENT.
THIS DOCUMENT COULD INCLUDE TECHNICAL INACCURACIES OR TYPOGRAPHICAL
ERRORS. CHANGES ARE PERIODICALLY ADDED TO THE INFORMATION HEREIN;
THESE CHANGES WILL BE INCORPORATED IN NEW EDITIONS OF THIS DOCUMENT.
CLOUD SG MAY MAKE IMPROVEMENTS AND/OR CHANGES IN THE PRODUCT(S), THE
PROGRAM(S), AND/OR THE SERVICES DESCRIBED IN THIS DOCUMENT AT ANY TIME
WITHOUT NOTICE.
THE CONTENTS OF THIS DOCUMENT MAY BE MODIFIED AND/OR QUALIFIED,
DIRECTLY OR INDIRECTLY, BY OTHER DOCUMENTATION WHICH ACCOMPANIES THIS
SOFTWARE, INCLUDING BUT NOT LIMITED TO ANY RELEASE NOTES AND "README"
FILES.
This and other products of Cloud SG may be covered by registered patents. For details, please refer
to the Virtual Patent Marking document located at https://www.cloud.com/legal.

Copyright© 2006-2026. Cloud Software Group, Inc. All Rights Reserved

https://www.cloud.com/legal
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CHAPTER 33
Version 6.2.3

This chapter contains the following topics:

1. New features

2. Changes in Functionality

3. Changes to third-party libraries

4. Closed Issues

5. Known Issues
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33.1 New features
This release contains the following new features:

Microsoft Entra ID support Support has been added to enable Drive connections
to Azure Blob Storage using Microsoft Entra
ID (formerly Azure AD) with client secret
credentials. When the ebx.addon.dama.azure.tenant.id,
ebx.addon.dama.azure.client.id, and
ebx.addon.dama.azure.client.secret properties are set,
the connector authenticates via Entra ID. Otherwise,
credentials default back to a storage account key. This
added support enhances security (least privilege, rotation,
auditability) by avoiding broad shared key usage. See the
Azure connection documentation for details.

See also   Connecting to Azure (authentication methods)
[p ]

Improved metadata display The Digital asset information tab now shows additional
metadata: file size, image width, and image height.

• Size is displayed in human-readable units (e.g.,
1024KB → 1MB, 1024MB → 1GB).

• For image and video assets, width and height are shown
when available.

Usability improvements Improvements in this release include:

• Users can now perform folder management actions
directly in the Folder navigation pane without leaving
the view. This streamlines common workflows and
reduces context switching. Available actions include:

• Creating a new folder in a specific Drive.

• Creating a new subfolder inside a folder.

• Editing a folder name.

• Deleting a folder (subject to permissions).

• Users can now rapidly de-select assets in the Manage
digital assets screen. Clicking anywhere in the
workspace outside of asset thumbnails, or list rows now
clears the current asset and folder selection.

Asset metadata synchronization Asset metadata background synchronization has been
included for assets added via a third-party server. This
ensures the Digital asset information tab displays accurate
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dimensions for externally synchronized assets and improves
consistency across Drives.

Font mapping support Support has been introduced for custom Chinese, Japanese,
Korean (CJK) font mapping in document previews.
Administrators can provide a font mapping JSON
file via the ebx.addon.dama.cjk.font.mapping.file.path
property to map CJK font names to installed system fonts.
This improves text rendering quality and coverage for CJK
in DOCX-to-PDF conversion and other document preview
workflows.

See also   Configuring CJK Font Mapping [p ]

Attention
As the add-on is undergoing revision, the documentation's images and descriptions of some
components might not exactly match the current UI.

33.2 Changes in Functionality
Generating an asset permalink now opens a pop-up dialog showing the URL in a read-only field with
a copy action and feedback. Previously, permalinks were generated silently without a dialog.

33.3 Changes to third-party libraries
This release contains the following changes to third-party libraries:

• Added com.drewnoakes:metadata-extractor dependency at version 2.19.0 to improve image and
media metadata extraction (dimensions, EXIF).

• The Apache Commons Lang library was updated to version 3.20.0.

• io.netty:netty-all was updated to version 4.2.9.Final.

• com.azure:azure-identity was updated to version 1.18.1.

• Jackson Core was updated to version 2.21.1.

• Jakarta Servlet was updated to version 6.0.

33.4 Closed Issues
This release contains the following closed issues:

• [EBXDAMA-1763] Assets are uploaded normally even when navigate away before clicking
Upload or Upload and attach.

• [EBXDAMA-2715] When using the REST API and updating or creating a record with no attached
assets, the getAttachment response is incorrect.

• [EBXDAMA-2989] When a preview cannot be generated, the No preview available screen
should display instead of a file not found error.
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• [EBXDAMA-3109] The collapse/expand icon is missing in record details view when using the
list view to display thumbnails.

• [EBXDAMA-3123] The tooltip for the File size column in the Digital asset version table is
incorrect.

33.5 Known Issues
This release contains the following known issues:

• [EBXDAMA-751] After a media type field is set to Hidden in all views and the data model is
published, it is no longer possible to upload or edit assets in that field. This issue occurs even
after permissions are set back to Visible in all views and the model is re-published.

• [EBXDAMA-2583] The add-on is not stable when deployed on a WebLogic application server.
Fatal errors can occur when trying to use the add-on's services. The root cause is under
investigation.

• [EBXDAMA-2646] When uploading assest from a Connector, the add-on is not able to recognize
duplicate assets that were uploaded (not using the add-on) to an externally managed server.

• [EBXDAMA-2894] It is possible that some DOCX file previews might not generate when
Microsoft Word is not installed. This is due to missing font files.

• [EBXDAMA-3056] If the Cancel button is clicked during a delete operation on 100 or more
assets, the operation is not cancelled and assets are still deleted.

• [EBXDAMA-3057] When attempting to delete assets from 2 Drives in the same operation and
one of the Drive's has an authentication issue, the displayed result states that all deletions failed.
However, some assets are still deleted and the asset thumbnails in the UI display a File not
found error.

• [EBXDAMA-3084] In certain cases the add-on is not able to preview DOCX files. This can occur
when the file contains invalid characters, or unsupported elements, such as charts, floating tables,
or other complex elements.

• [EBXDAMA-3085] In instances where PPTX files contain complex shapes, the add-on cannot
generate a preview. This is due to a third-party technical limitation.

• [EBXDAMA-3086] The first time a large file is previewed, users might experience a delay while
the preview is generated.

• Searching for assets in the media-type field using quick search is not supported. However, when
previewing some file types, such as PDFs, you can search for text within the file.

• The configuration is not updated for the supported file extensions after users access the Digital
Asset Manager widget.

• Document previews cannot display Vietnamese text.

• When accessing assets in an external Drive, error messages may display when selecting all assets.
This can be the result of access limitations put in place by the third-party tool.

• Thumbnails of some uploaded SVG files do not display correctly.

• Previews of PPT, PPTX, DOC and DOCX files cannot display charts due to a limitation of the
library used to generate the preview.
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CHAPTER 34
All release notes

This chapter contains the following topics:

1. Version 6.2.3

2. Version 6.2.2

3. Version 6.2.1

4. Version 6.2.0

5. Version 6.1.3

6. Version 6.1.2

7. Version 6.1.1

8. Version 6.1.0

9. Version 2.5.2

10.Version 2.5.1

11.Version 2.5.0

12.Version 2.4.1

13.Version 2.4.0

14.Version 2.3.2

15.Version 2.3.1

16.Version 2.3.0

17.Version 2.2.1

18.Version 2.2.0

19.Version 2.1.1

20.Version 2.1.0

21.Version 2.0.1

22.Version 2.0.0

23.Version 1.8.8

24.Version 1.8.7

25.Release Notes 1.8.6

26.Release Notes 1.8.5
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27.Release Notes 1.8.4

28.Release Notes 1.8.3

29.Release Notes 1.8.2

30.Release Notes 1.8.1

31.Release Notes 1.8.0

32.Release Notes 1.7.0

33.Release Notes 1.6.0

34.Release Notes 1.5.1

35.Release Notes 1.5.0

36.Release Notes 1.4.3

37.Release Notes 1.4.2

38.Release Notes 1.4.1

39.Release Notes 1.4.0

40.Release Note 1.3.0

41.Release Note 1.2.2

42.Release Note 1.2.1

43.Release Note 1.2.0

44.Release Note 1.1.1

45.Release Note 1.1.0

46.Release Note 1.0.2 fix 001

47.Release Note 1.0.3

48.Release Note 1.0.2

49.Release Note 1.0.1

50.Release Note 1.0.0
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34.1 Version 6.2.3

New features
This release contains the following new features:

Microsoft Entra ID support Support has been added to enable Drive connections
to Azure Blob Storage using Microsoft Entra
ID (formerly Azure AD) with client secret
credentials. When the ebx.addon.dama.azure.tenant.id,
ebx.addon.dama.azure.client.id, and
ebx.addon.dama.azure.client.secret properties are set,
the connector authenticates via Entra ID. Otherwise,
credentials default back to a storage account key. This
added support enhances security (least privilege, rotation,
auditability) by avoiding broad shared key usage. See the
Azure connection documentation for details.

See also   Connecting to Azure (authentication methods)
[p ]

Improved metadata display The Digital asset information tab now shows additional
metadata: file size, image width, and image height.

• Size is displayed in human-readable units (e.g.,
1024KB → 1MB, 1024MB → 1GB).

• For image and video assets, width and height are shown
when available.

Usability improvements Improvements in this release include:

• Users can now perform folder management actions
directly in the Folder navigation pane without leaving
the view. This streamlines common workflows and
reduces context switching. Available actions include:

• Creating a new folder in a specific Drive.

• Creating a new subfolder inside a folder.

• Editing a folder name.

• Deleting a folder (subject to permissions).

• Users can now rapidly de-select assets in the Manage
digital assets screen. Clicking anywhere in the
workspace outside of asset thumbnails, or list rows now
clears the current asset and folder selection.

Asset metadata synchronization Asset metadata background synchronization has been
included for assets added via a third-party server. This
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ensures the Digital asset information tab displays accurate
dimensions for externally synchronized assets and improves
consistency across Drives.

Font mapping support Support has been introduced for custom Chinese, Japanese,
Korean (CJK) font mapping in document previews.
Administrators can provide a font mapping JSON
file via the ebx.addon.dama.cjk.font.mapping.file.path
property to map CJK font names to installed system fonts.
This improves text rendering quality and coverage for CJK
in DOCX-to-PDF conversion and other document preview
workflows.

See also   Configuring CJK Font Mapping [p ]

Attention
As the add-on is undergoing revision, the documentation's images and descriptions of some
components might not exactly match the current UI.

Changes in Functionality
Generating an asset permalink now opens a pop-up dialog showing the URL in a read-only field with
a copy action and feedback. Previously, permalinks were generated silently without a dialog.

Changes to third-party libraries
This release contains the following changes to third-party libraries:

• Added com.drewnoakes:metadata-extractor dependency at version 2.19.0 to improve image and
media metadata extraction (dimensions, EXIF).

• The Apache Commons Lang library was updated to version 3.20.0.

• io.netty:netty-all was updated to version 4.2.9.Final.

• com.azure:azure-identity was updated to version 1.18.1.

• Jackson Core was updated to version 2.21.1.

• Jakarta Servlet was updated to version 6.0.

Closed Issues
This release contains the following closed issues:

• [EBXDAMA-1763] Assets are uploaded normally even when navigate away before clicking
Upload or Upload and attach.

• [EBXDAMA-2715] When using the REST API and updating or creating a record with no attached
assets, the getAttachment response is incorrect.

• [EBXDAMA-2989] When a preview cannot be generated, the No preview available screen
should display instead of a file not found error.
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• [EBXDAMA-3109] The collapse/expand icon is missing in record details view when using the
list view to display thumbnails.

• [EBXDAMA-3123] The tooltip for the File size column in the Digital asset version table is
incorrect.

Known Issues
This release contains the following known issues:

• [EBXDAMA-751] After a media type field is set to Hidden in all views and the data model is
published, it is no longer possible to upload or edit assets in that field. This issue occurs even
after permissions are set back to Visible in all views and the model is re-published.

• [EBXDAMA-2583] The add-on is not stable when deployed on a WebLogic application server.
Fatal errors can occur when trying to use the add-on's services. The root cause is under
investigation.

• [EBXDAMA-2646] When uploading assest from a Connector, the add-on is not able to recognize
duplicate assets that were uploaded (not using the add-on) to an externally managed server.

• [EBXDAMA-2894] It is possible that some DOCX file previews might not generate when
Microsoft Word is not installed. This is due to missing font files.

• [EBXDAMA-3056] If the Cancel button is clicked during a delete operation on 100 or more
assets, the operation is not cancelled and assets are still deleted.

• [EBXDAMA-3057] When attempting to delete assets from 2 Drives in the same operation and
one of the Drive's has an authentication issue, the displayed result states that all deletions failed.
However, some assets are still deleted and the asset thumbnails in the UI display a File not
found error.

• [EBXDAMA-3084] In certain cases the add-on is not able to preview DOCX files. This can occur
when the file contains invalid characters, or unsupported elements, such as charts, floating tables,
or other complex elements.

• [EBXDAMA-3085] In instances where PPTX files contain complex shapes, the add-on cannot
generate a preview. This is due to a third-party technical limitation.

• [EBXDAMA-3086] The first time a large file is previewed, users might experience a delay while
the preview is generated.

• Searching for assets in the media-type field using quick search is not supported. However, when
previewing some file types, such as PDFs, you can search for text within the file.

• The configuration is not updated for the supported file extensions after users access the Digital
Asset Manager widget.

• Document previews cannot display Vietnamese text.

• When accessing assets in an external Drive, error messages may display when selecting all assets.
This can be the result of access limitations put in place by the third-party tool.

• Thumbnails of some uploaded SVG files do not display correctly.

• Previews of PPT, PPTX, DOC and DOCX files cannot display charts due to a limitation of the
library used to generate the preview.
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34.2 Version 6.2.2

New features
This release contains the following new features:

• As a convenient way for an administrator to get an asset's UUID, it now displays in the UI as one
of the attributes when viewing an asset in the Digital asset table.

• New REST API endpoints enable programmatic management and interaction with folders. This
enhancement aligns folder-related REST operations with existing UI capabilities, improving
automation and integration potential. Most endpoints for POST, PUT, and Delete were previously
available, but were refactored to accommodate folder-related actions. This release includes the
addition of new endpoints were added for GET search and download:

• /v1/folder/{dataspace}/{dataset}:search

• /v1/folder/download

• Previously, the Drive screen only supported a grid view, limiting the amount of visible information
per asset and number of assets displayed. Users needed to open asset previews or access the
Version management tab to see more details. Now you can switch between Grid view and List
view in the Drive screen. The new List view displays assets and folders in a table layout with
extended details, offering improved information visibility without requiring additional clicks.

• The file size limit for document previews was increased from 5MB to 20MB. Additionally, parts
of the document can be previewed without waiting for the entire file to load.

• The documentation now includes instructions for encoding special characters in REST calls. See
the Developer Guide > REST overview section for details.

• Performance was improved:

• When deleting digital assets.

• For operations on dataspaces, such as creation, deletion, and dataspace merge.

• Usability improvements:

• The top level of the Folder navigation pane now displays Drives. Users can browse
and access folders within different Drives directly from the navigation pane. This change
improves navigation by allowing direct access to all available Drives without requiring
additional steps or context switching.

• To make it easier to find a tag when filtering assets in the Drive view, tags now display in
alphabetical order.

• A progress bar was added to communicate the real-time status when deleting and uploading
assets. Additionally, individual assets now also display progress indicators during the upload
process.
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• After asset deletion or upload completes, the following statistics are now displayed for
the total number of: processed assets, successfully deleted/uploaded assets, unsuccessfully
processed assets.

Attention
As the add-on is undergoing revision, the documentation's images and descriptions of some
components might not exactly match the current UI.

Changes in Functionality
This release contains the following changes in functionality:

• The TIBCO EBX® Digital Asset Manager Add-on no longer supports previews for Word 2003
DOC files. The add-on continues to support preview functionality for Word 2007 and newer
DOCX files.

• Previously, retrieving an asset's current version via the Java API always returned the version
marked as current in the Drive. This behavior has changed. The API now returns the version that
is current in the context of the specified dataset, which may differ from the Drive's current version.

Changes to third-party libraries
This release contains the following changes to third-party libraries:

• Updated Apache POI and related libraries (poi, poi-ooxml, poi-ooxml-full, poi-scratchpad) to
version 5.4.1.

• Updated docx4j-JAXB-ReferenceImpl and docx4j-export-fo to version 11.5.2.

• Updated Azure libraries:

• azure-core-http-netty to version 1.15.12.

• azure-core to version 1.55.4.

• azure-identity to version 1.16.2.

• Updated pdfbox, pdfbox-tools, fontbox, preflight, and xmpbox to version 3.0.5.

• Updated batik-all to version 1.18.

• Updated xmlgraphics-commons to version 2.10.

Closed Issues
This release contains the following closed issues:

• [EBXDAMA-2724] Digital assets are accessible via URL without having to log into EBX®.

• [EBXDAMA-3059] File names containing Chinese characters are incorrectly encoded.

• [EBXDAMA-3071] In the Digital asset table, users can still delete assets that belong to other
users, even when they do not have permission to do so.

• [EBXDAMA-3094] The Manage digital assets screen is not accessible via IFrame.

• [EBXDAMA-3099] Only one table archive should be imported when multiple files are required.
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Known Issues
This release contains the following known issues:

• [EBXDAMA-751] After a media type field is set to Hidden in all views and the data model is
published, it is no longer possible to upload or edit assets in that field. This issue occurs even
after permissions are set back to Visible in all views and the model is re-published.

• [EBXDAMA-2583] The add-on is not stable when deployed on a WebLogic application server.
Fatal errors can occur when trying to use the add-on's services. The root cause is under
investigation.

• [EBXDAMA-2646] When uploading assest from a Connector, the add-on is not able to recognize
duplicate assets that were uploaded (not using the add-on) to an externally managed server.

• [EBXDAMA-2894] It is possible that some DOCX file previews might not generate when
Microsoft Word is not installed. This is due to missing font files.

• [EBXDAMA-3056] If the Cancel button is clicked during a delete operation on 100 or more
assets, the operation is not cancelled and assets are still deleted.

• [EBXDAMA-3057] When attempting to delete assets from 2 Drives in the same operation and
one of the Drive's has an authentication issue, the displayed result states that all deletions failed.
However, some assets are still deleted and the asset thumbnails in the UI display a File not
found error.

• [EBXDAMA-3084] In certain cases the add-on is not able to preview DOCX files. This can occur
when the file contains invalid characters, or unsupported elements, such as charts, floating tables,
or other complex elements.

• [EBXDAMA-3085] In instances where PPTX files contain complex shapes, the add-on cannot
generate a preview. This is due to a third-party technical limitation.

• [EBXDAMA-3086] The first time a large file is previewed, users might experience a delay while
the preview is generated.

• Searching for assets in the media-type field using quick search is not supported. However, when
previewing some file types, such as PDFs, you can search for text within the file.

• The configuration is not updated for the supported file extensions after users access the Digital
Asset Manager widget.

• Document previews cannot display Vietnamese text.

• When accessing assets in an external Drive, error messages may display when selecting all assets.
This can be the result of access limitations put in place by the third-party tool.

• Thumbnails of some uploaded SVG files do not display correctly.

• Previews of PPT, PPTX, DOC and DOCX files cannot display charts due to a limitation of the
library used to generate the preview.

34.3 Version 6.2.1

New features
This release contains the following new features:
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• The REST API was updated to allow retrieval of an asset using its UUID. The endpoint for this
API is: http://<host>/ebx-addon-dama/rest/v1/asset/<assetUuid>:getInfo

• You can now share an asset via its URL. This allows you to share assets with colleagues
that might not have access to EBX®. The URL link expiration time defaults to 30
minutes. However, an administrator can adjust this limit in the ebx.properties file using the
ebx.addon.dama.rest.token.timeout property.

• When an administrator imports a ZIP file to an internal Drive, the folder hierarchy is now
preserved. If an imported folder already exists in the Drive, you can choose to replace the existing
folder, or keep both. Please note that this feature is not available for externally managed Drives
(AWS, Microsoft Azure, Sharepoint, etc.).

• A new transformation function was added to the TIBCO EBX® Data Integration Add-on that
exports asset file names, instead of their UUIDs. This provides a more streamlined approach to
automatically attaching assets with CSV or Excel import operations.

• When searching for assets in a Drive, you can now switch between the Exact and Contains
modes. The selected mode determines whether the search operation only returns results that
exactly match the keyword, or that the results only include the search term.

Attention
As the add-on is undergoing revision, the documentation's images and descriptions of some
components might not exactly match the current UI.

Changes in Functionality
This release includes no changes to functionality.

Changes to third-party libraries
This release contains the following changes to third-party libraries:

• The Microsoft Azure Client Library for Identity was updated to version 1.14.1.

• The Kotlin Stdlib was updated to version 2.1.0.

• The Apache Commons IO library was updated to version 2.18.0.

Closed Issues
This release contains the following closed issues:

• [EBXDAMA-2351] It should not be possible to input the version name and comment when these
fields are read-only.

• [EBXDAMA-2427] In certain cases, duplicate assets are not uploaded and attached in the tabular
view when using the quick upload and attach.

• [EBXDAMA-2538] An issue occurs when trying to delete an asset version from theEdit digital
asset screen.

• [EBXDAMA-2656] Externally managed assets cannot be previewed.

• [EBXDAMA-22658] The Deactivate icon does not display when previewing assets from the
Drive and Manage digital assets screen.
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• [EBXDAMA-2680] The Detatch icon displays even after attempting to attach an asset that is
invalid.

• [EBXDAMA-2684] The Tags field on the Upload new digital asset screen is not aligned
correctly.

• [EBXDAMA-2708] All attached assets display in-line in the tabular view.

• [EBXDAMA-2723] The filter criterion screen on the tile view is not aligned correctly.

• [EBXDAMA-2746] An error message displays when a duplicate internal Drive is created and
the connecter is changed to an externally managed Drive.

• [EBXDAMA-2783] The message does not display correctly when no assets were found in the
Drive.

• [EBXDAMA-2792] An uploaded asset is duplicated and a File not found message displays
on a custom Drive.

• [EBXDAMA-2853] Users can print a PDF using Ctrl+P even if the Share and download option
in the D.A.C is disabled.

• [EBXDAMA-2866] A File not found error occurs on an asset preview.

• [EBXDAMA-2867] The correct error message should display when users try to download an
image that does not exist from the Edit digital asset screen.

• [EBXDAMA-2873] Multiple asset download is not working on EBX® Container Edition.

• [EBXDAMA-2919] An issue occurs in the API when using EditorFilterContext.

• [EBXDAMA-2920] An error message is logged when opening a digital asset that is a document.

Known Issues
This release contains the following known issues:

• [EBXDAMA-751] After a media type field is set to Hidden in all views and the data model is
published, it is no longer possible to upload or edit assets in that field. This issue occurs even
after permissions are set back to Visible in all views and the model is re-published.

• [EBXDAMA-2583] The add-on is not stable when deployed on a WebLogic application server.
Fatal errors can occur when trying to use the add-on's services. The root cause is under
investigation.

• [EBXDAMA-2894] It is possible that some DOCX file previews might not generate when
Microsoft Word is not installed. This is due to missing font files.

• Searching for assets in the media-type field using quick search is not supported. However, when
previewing some file types, such as PDFs, you can search for text within the file.

• The configuration is not updated for the supported file extensions after users access the Digital
Asset Manager widget.

• Document previews cannot display Vietnamese text.

• When accessing assets in an external Drive, error messages may display when selecting all assets.
This can be the result of access limitations put in place by the third-party tool.

• Thumbnails of some uploaded SVG files do not display correctly.

• Previews of PPT, PPTX, DOC and DOCX files cannot display charts due to a limitation of the
library used to generate the preview.
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34.4 Version 6.2.0

New features
This release contains the following new features:

• The add-on's Migrate digital asset manager data service can now successfully migrate
configuration settings from versions of the add-on compatible with TIBCO EBX® version 5.9.X
to version 6.X.

• The Max usable space option was added to configuration settings for external connectors.
Administrators can use this option to specify how much space is used for Drives in externally
managed storage locations.

• The REST API was updated to allow digital asset retrieval using an asset or version UUID. This
update means that assets can be retrieved without having to be attached to a record.

Attention
As the add-on is undergoing revision, the documentation's images and descriptions of some
components might not exactly match the current UI.

Changes in Functionality
This release includes no changes to functionality.

Changes to third-party libraries
The following libraries were updated:

• Jackson Databind was updated to version 2.16.0.

• Microsoft Graph was updated to version 5.8.0.

• Apache Commons Compress was updated to version 1.26.1.

• AWS Java SDK for Amazon S3 was updated to version 1.12.676.

• Nimbus JOSE JWT was updated to version 9.37.2.

• Reactor Netty was updated to version 1.0.45.

• Okio was updated to version 3.6.0.

Closed Issues
This release contains the following closed issues:

• [EBXDAMA-2748] Digital assets do not display after reverting the action of deactivating an
attached asset.

• [EBXDAMA-2784] Digital assets still display in certain UI components after being deactivated.

• [EBXDAMA-2787] An error can occur if digital assets are deleted immediately after they are
uploaded.

• [EBXDAMA-2818] The wrong asset version displays after changing an asset's version and
downloading it.
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• [EBXDAMA-2819] An error occurs when previewing a video in multiple UI components.

• [EBXDAMA-2856] The REST API response for getAllAsset is missing the ? separator.

Known Issues
This release contains the following known issues:

• [EBXDAMA-751] After a media type field is set to Hidden in all views and the data model is
published, it is no longer possible to upload or edit assets in that field. This issue occurs even
after permissions are set back to Visible in all views and the model is re-published.

• [EBXDAMA-2583] The add-on is not stable when deployed on a WebLogic application server.
Fatal errors can occur when trying to use the add-on's services. The root cause is under
investigation.

• Searching for assets in the media-type field using quick search is not supported. However, when
previewing some file types, such as PDFs, you can search for text within the file.

• The configuration is not updated for the supported file extensions after users access the Digital
Asset Manager widget.

• Document previews cannot display Vietnamese text.

• When accessing assets in an external Drive, error messages may display when selecting all assets.
This can be the result of access limitations put in place by the third-party tool.

• Thumbnails of some uploaded SVG files do not display correctly.

• Previews of PPT, PPTX, DOC and DOCX files cannot display charts due to a limitation of the
library used to generate the preview.

34.5 Version 6.1.3

New features
This release contains the following new features:

• It is now possible to create a tile view in EBX® that displays an image that is a digital asset.

• The UI when viewing a Drive was enhanced to include a pagination feature that displays the
number of pages containing assets and allows you to navigate. Note, that when displaying the
pagination information on a Drive connected to an externally managed location, the add-on
cannot display the final page of assets if the API isn't implemented correctly. Please ensure the
ExternalSearchRequest adds the total number of fields.

Attention
As the add-on is undergoing revision, the documentation's images and descriptions of some
components might not exactly match the current UI.

Changes in Functionality
This release includes no changes to functionality.
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Changes to third-party libraries
The Netty library was updated to version 4.1.100.Final.

Closed Issues
This release contains the following closed issues:

• [EBXDAMA-2025] An error message displays when Metadata nature includes the "|" character.

• [EBXDAMA-2367] Other user's assets can be moved to another Drive or folder even when the
Edit other user's assets permission is disabled.

• [EBXDAMA-2505]Sort by Last update does not apply for folders when uploading or deleting
assets under the folder.

• [EBXDAMA-2583] The add-on's services have fatal errors when deployed on WebLogic.

• [EBXDAMA-2590] The success message after moving only distinct assets is missing.

• [EBXDAMA-2618] A custom or externally managed Drive can be created even when mandatory
fields are blank.

• [EBXDAMA-2621] The file not found thumbnail is not displayed in the Drive screen after
moving folders that include assets.

• [EBXDAMA-2659] Invalid assets with Asset name pattern in DAC configuration for external
management can be successfully uploaded and attached.

• [EBXDAMA-2665] The file not found thumbnail displays on the tabular view when deleting
folders that include assets.

• [EBXDAMA-2678] Duplicate assets are not recognized when their file extensions have different
letter case.

• [EBXDAMA-2718] An issue occurs in EditorFilterContext.

• [EBXDAMA-2742] The REST v2 documentation cannot be retrieved.

• [EBXDAMA-2758] Digital assets cannot be previewed from dataspace snapshots.

Known Issues
This release contains the following known issues:

• [EBXDAMA-751] After a media type field is set to Hidden in all views and the data model is
published, it is no longer possible to upload or edit assets in that field. This issue occurs even
after permissions are set back to Visible in all views and the model is re-published.

• [EBXDAMA-2583] The add-on is not stable when deployed on a WebLogic application server.
Fatal errors can occur when trying to use the add-on's services. The root cause is under
investigation.

• Searching for assets in the media-type field using quick search is not supported. However, when
previewing some file types, such as PDFs, you can search for text within the file.

• The configuration is not updated for the supported file extensions after users access the Digital
Asset Manager widget.

• Document previews cannot display Vietnamese text.
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• When accessing assets in an external Drive, error messages may display when selecting all assets.
This can be the result of access limitations put in place by the third-party tool.

• Thumbnails of some uploaded SVG files do not display correctly.

• Previews of PPT, PPTX, DOC and DOCX files cannot display charts due to a limitation of the
library used to generate the preview.

34.6 Version 6.1.2

New features
This release contains the following new features:

• You can now specify the expiration time limit for asset URLs in the ebx.properties file by
changing the value of ebx.addon.dama.rest.token.timeout. This property defaults to a value of
1800 seconds (30 minutes). Also note that the useAddonToken parameter was removed from all
REST endpoints.

• It is now possible to use drag and drop functionality to move assets between folders, and to move
folders.

• The ability to change the downloaded size of assets that are images is now available when using
the API.

Attention
As the add-on is undergoing revision, the documentation's images and descriptions of some
components might not exactly match the current UI.

Changes in Functionality
This release includes no changes to functionality.

Changes to third-party libraries
The following third-party libraries were updated:

• The FasterXML jackson core library was updated to version 2.15.2.

• Guava: Google Core Libraries For Java was updated to version 32.0.1-jre

• Netty/All In One: NIO client server framework was updated to version 4.1.94.Final

• Batik aggregate artifact was updated to version 1.17

• Microsoft Azure Client Library For Blob Storage was updated to version 12.23.1

Closed Issues
This release contains the following closed issues:

• [EBXDAMA-2381] Other user's assets can be moved even when the Edit other user's assets
permission is disabled.

• [EBXDAMA-2467] Multiple assets can not be simultaneously quick attached in the tabular view.
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• [EBXDAMA-2522] After successful import, the success screen displays even when re-accessing
the Import from a ZIP file service in the Digital asset table

• [EBXDAMA-2526] The Drive field should be disabled when creating new version from the
Digital asset table.

• [EBXDAMA-2536] A SharePoint Drive can be created when it links to a folder name from in
a different Drive on the EBX® server.

• [EBXDAMA-2539] A SharePoint Drive can be created that links to a document library that
doesn't exist.

• [EBXDAMA-2542] When creating a new version of an asset that is the same as the existing asset
in a Drive, the two assets cannot be downloaded at the same time.

• [EBXDAMD-2561] A new folder cannot be created within an Amazon S3 Drive.

• [EBXDAMA-2591] The message indicating a successful move does not display after moving
only distinct assets.

• [EBXDAMA-2612] Externally managed assets can not be downloaded in the UI.

Known Issues
This release contains the following known issues:

• [EBXDAMA-751] After a media type field is set to Hidden in all views and the data model is
published, it is no longer possible to upload or edit assets in that field. This issue occurs even
after permissions are set back to Visible in all views and the model is re-published.

• [EBXDAMA-2583] The add-on is not stable when deployed on a WebLogic application server.
Fatal errors can occur when trying to use the add-on's services. The root cause is under
investigation.

• Searching for assets in the media-type field using quick search is not supported. However, when
previewing some file types, such as PDFs, you can search for text within the file.

• The configuration is not updated for the supported file extensions after users access the Digital
Asset Manager widget.

• Document previews cannot display Vietnamese text.

• When accessing assets in an external Drive, error messages may display when selecting all assets.
This can be the result of access limitations put in place by the third-party tool.

• Thumbnails of some uploaded SVG files do not display correctly.

• Previews of PPT, PPTX, DOC and DOCX files cannot display charts due to a limitation of the
library used to generate the preview.

34.7 Version 6.1.1

New features
This release contains the following new features:

• An option was added to Drive configurations that disables automatic synchronization between
the add-on and an external Drive. When this option is disabled, it can help improve performance.
You can synchronize manually as needed when viewing the Drive.
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• Digital assets can now be migrated using the EBX® staging feature.

• Users with administrative access can now download a ZIP file of selected assets when viewing
the Digital asset table. This provides a convenient way to download assets contained in different
Drives.

• Digital assets that are images can now be resized when downloading.

• The Image configuration property is now available on Drives and Digital Asset Components for
external storage locations. This property allows a maximum image size to be defined.

• The options to restrict file upload are now available for Drives and Digital Asset Components
that connect to external storage locations.

• The filter that sorts digital assets can now also sort folders.

• This release contains the following API updates:

• The Java API's DigitalAsset and DigitalAssetVersion classes now include getSize() to
retrieve an image's size.

• The responses from the following REST API endpoints now include the size property with
width and height properties when the asset type is an image:

• :search

• :getInfo

• :getAttachment

• :upload

Attention
As the add-on is undergoing revision, the documentation's images and descriptions of some
components might not exactly match the current UI.

Changes in Functionality
This release includes no changes to functionality.

Changes to third-party libraries
The following third-party libraries were updated:

• Guava: Google Core Libraries For Java was updated to version 32.0.1-jre

• Netty/All In One: NIO client server framework was updated to version 4.1.94.Final

Closed Issues
This release contains the following closed issues:

• [EBXDAMA-1131] Users can edit an asset when opening an inherited record inside a child
dataset.

• [EBXDAMA-2308] While searching in a Drive, nothing happens when typing.

• [EBXDAMA-2315] Other user's assets can be edited even when Edit other user's assets option
is disabled in the DAC.

• [EBXDAMA-2347] Invalid assets can be successfully attached.
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• [EBXDAMA-2350] The focus of the last selected folder is removed.

• [EBXDAMA-2371] The breadcrumb cannot react after accessing the asset information details
screen.

• [EBXDAMA-2373] The order of assets is changed after deactivating the assets.

• [EBXDAMA-2387] The total number of assets on the Drive is incorrect when queried via the
API.

• [EBXDAMA-2418] Several icons are not visible and assets cannot be previewed when using the
search feature.

Known Issues
This release contains the following known issues:

• The add-on is not stable when deployed on a WebLogic application server. Fatal errors can occur
when trying to use the add-on's services. The root cause is under investigation.

• Searching for assets in the media-type field using quick search is not supported. However, when
previewing some file types, such as PDFs, you can search for text within the file.

• The configuration is not updated for the supported file extensions after users access the Digital
Asset Manager widget.

• Document previews cannot display Vietnamese text.

• When accessing assets in an external Drive, error messages may display when selecting all assets.
This can be the result of access limitations put in place by the third-party tool.

• Thumbnails of some uploaded SVG files do not display correctly.

• Previews of PPT, PPTX, DOC and DOCX files cannot display charts due to a limitation of the
library used to generate the preview.

34.8 Version 6.1.0
Released: March 2023

New features
This release contains the following new features:

• A new built-in connector for Microsoft SharePoint is available.

• A new built-in connector for Google Drive is available.

• The add-on was updated to ensure compatibility with the new TIBCO EBX® staging feature.
Use this feature to migrate configuration settings from one environment to another. See the
EBX® documentation for more details. The available staging elements for the EBX Digital Asset
Manager Add-on are the Digital Asset Components (DACs). Staging a DAC configuration will
also stage any related Drive configurations, Image configurations, etc.

• The add-on was updated to ensure compatibility with the way TIBCO EBX® now handles URL
encoding. Please see the EBX® release notes for more details.

• The ability to create folders in Drives and move assets between folders was added. This enables
asset organization and classification. Folders can also be shared and downloaded.

• User Experience enhancements:
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• An advanced search mode is now available to search on inclusive or exclusive criteria types.

• Multiple file extensions and digital asset types can now be applied when filtering assets in
a Drive.

• It is no longer possible to input a last updated date or creation date that is greater than the
current date.

• Asset URLs are now optimized when sharing the asset via email.

• When choosing a Drive, you can now search for the desired Drive in the menu.

• REST API updates:

• A new V2 REST API was added that includes:

• An endpoint for the TIBCO EBX GO Add-on to retrieve asset information.

• Endpoints to select and search for assets of multiple types, extensions, and criteria
matches.

• The V1 REST API can now physically delete assets. This includes assets uploaded by the
current user and other users.

Attention
As the add-on is undergoing revision, the documentation's images and descriptions of some
components might not exactly match the current UI.

Changes in Functionality
This release includes the following changes to functionality:

• The permissions for deleting and deactivating assets were decoupled. When a user's permission
to delete assets is restricted, they can still deactivate assets.

• The permission setting Edit other user's assets is now coupled with the ability to deactivate
assets. When this setting is enabled, users can deactivate assets uploaded by other users and vice
versa.

Changes to third-party libraries
This release contains the following changes to third-party libraries:

• Google library updates:

• Guava: Google Core Libraries For Java to version 31.1-jre

• google-api-client to version 2.0.0

• google-api-services-drive to version v3-rev20220815-2.0.0

• YAML 1.1 parser and emitter for Java library was updated to version 2.0.

• JSON Small and Fast Parser library was updated to version 2.4.10.

• The FasterXML jackson core library was updated to version 2.14.2.

• The Apache Commons FileUpload library was updated to version 1.5.

• The iText library was removed. Note if you experience issues displaying DOCX files, you might
need to manually deploy iText in your environment.
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Closed Issues
This release contains the following closed issues:

• [EBXDAMA-1609] The wrong error message is displayed in the Manage digital asset screen
when the Region and Bucket name do not match.

• [EBXDAMA-1683] The display is incorrect when registering a connector but not changing the
S3 information of a Custom Drive.

• [EBXDAMA-1684] Wrong with deleted assets from Custom connector when we haven't reload
the drive.

• [EBXDAMA-1818] It is not possible to upload into the Icon Drive in the Manage digital assets
screen.

• [EBXDAMA-1819] The prefix [ON] incorrectly displays with the Icon Drive when creating a
new version.

• [EBXDAMA-1975] An error message is displayed in Amazon S3 drive screen when clicking the
Folder name combo-box.

• [EBXDAMA-1984] An unexpected error pop-up displays when uploading invalid files in the
tabular view.

• [EBXDAMA-2021] An error thumbnail is displayed in the tabular view with the attached assets
that are not moved to another drive.

• [EBXDAMA-2026] An HTML file is downloaded instead of the correct asset when accessing
the Edit digital asset feature from the Manage digital asset screen.

• [EBXDAMA-2038] An image cannot be added when the media field is directly under the root
in the data model.

• [EBXDAMA-2166] Documentation is missing from the REST API on multipart fields.

• [EBXDAMA-2256] [API] An asset cannot be uploaded and attached when the maximum
occurrence is set to 1.

Known Issues
This release contains the following known issues:

• Searching for assets in the media-type field using quick search is not supported. However, when
previewing some file types, such as PDFs, you can search for text within the file.

• The configuration is not updated for the supported file extensions after users access the Digital
Asset Manager widget.

• Document previews cannot display Vietnamese text.

• When accessing assets in an external Drive, error messages may display when selecting all assets.
This can be the result of access limitations put in place by the third-party tool.

• Thumbnails of some uploaded SVG files do not display correctly.

• Previews of PPT, PPTX, DOC and DOCX files cannot display charts due to a limitation of the
library used to generate the preview.
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34.9 Version 2.5.2
Released: February 2023

New features
This release contains no new features.

Attention
As the add-on is undergoing revision, the documentation's images and descriptions of some
components might not exactly match the current UI.

Changes in Functionality
This release includes no changes to functionality.

Changes to third-party libraries
The Zip4j library for zip files and streams was updated to version 2.11.3.
The Microsoft Azure Client Library For Blob Storage library was updated to version 12.20.2.

Closed Issues
This release contains no closed issues.

Known Issues
This release contains the following known issues:

• Searching for assets in the media-type field using quick search is not supported. However, when
previewing some file types, such as PDFs, you can search for text within the file.

• The configuration is not updated for the supported file extensions after users access the Digital
Asset Manager widget.

• Document previews cannot display Vietnamese text.

• When accessing assets in an external Drive, error messages may display when selecting all assets.
This can be the result of access limitations put in place by the third-party tool.

• Thumbnails of some uploaded SVG files do not display correctly.

• Previews of PPT, PPTX, DOC and DOCX files cannot display charts due to a limitation of the
library used to generate the preview.

34.10 Version 2.5.1
Released: November 2022
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New features
This release contains no new features.

Attention
As the add-on is undergoing revision, the documentation's images and descriptions of some
components might not exactly match the current UI.

Changes in Functionality
This release includes no changes to functionality.

Changes to third-party libraries
The FasterXML jackson-databind library was updated to version 2.13.4.2.

Closed Issues
This release contains no closed issues.

Known Issues
This release contains the following known issues:

• Searching for assets in the media-type field using quick search is not supported. However, when
previewing some file types, such as PDFs, you can search for text within the file.

• The configuration is not updated for the supported file extensions after users access the Digital
Asset Manager widget.

• Document previews cannot display Vietnamese text.

• When accessing assets in an external Drive, error messages may display when selecting all assets.
This can be the result of access limitations put in place by the third-party tool.

• Thumbnails of some uploaded SVG files do not display correctly.

• Previews of PPT, PPTX, DOC and DOCX files cannot display charts due to a limitation of the
library used to generate the preview.

34.11 Version 2.5.0
Released: September 2022

New features
This release contains the following new features:

• A built-in connector is available for Microsoft Azure.

• An option is available to move assets from one Drive to another.

• User Experience enhancements:

• Permission options renamed for clarity.
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• When removing assets from an upload, the confirmation dialog no longer displays each time
an asset is removed.

• Tabular view: pagination via next and previous actions is available when multiple assets are
attached to a record.

• When viewing an asset preview, the ESC key is a shortcut to closing the preview.

• When viewing assets shared via a permalink or email, the attach icon, detach icon, and
attachments pane are hidden.

• Asset previews are available by clicking the asset's thumbnail in the tabular view. Additionally,
assets can be downloaded from the tabular view.

• Permission updates:

• Two new permission options are available on Drive and D.A.C configurations: Delete other
user's assets and Edit other user's assets.

• The behavior of the View other user's assets permission was updated so that users with this
permission have read-only access to other user's assets. They cannot edit or delete them.

• When the Quick upload and attach permission is enabled, it applies when uploading from
the tabular view.

• The Reject duplicates setting is applied when:

• Users upload assets from the record's details view (with quick upload and attach permission),
or the tabular view.

• Administrators upload an asset from the Administration panel, move an asset to another
Drive, or upload a ZIP file.

• The ability to upload assets from the tabular view is manageable using the Display the upload
button in the D.A.C configuration.

• When configuring an S3 connection, the folder is selectable from a list of existing folders.
Alternatively, the option is available to create a new folder.

• When configuring an S3 connection, the bucket name is check for valid input.

• There is an option to delete asset versions from the Version management tab when accessing
from the Administration panel.

• REST API Updates:

• The REST API was refactored.

• The getInfo endpoint was updated to include a list of all versions of an asset.

Attention
As the add-on is undergoing revision, the documentation's images and descriptions of some
components might not exactly match the current UI.

Changes in Functionality
This release includes no changes to functionality.

Changes to third-party libraries
This release contains no changes to third-party libraries.
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Closed Issues
This release contains the following closed issues:

• [EBXDAMA-929] If the server is not reloaded, deactivated assets can still be attached.

• [EBXDAMA-947] The Actions menu does not display correctly.

• [EBXDAMA-953] Files from an external Drive cannot be previewed in the Edit digital asset
screen.

Known Issues
This release contains the following known issues:

• Searching for assets in the media-type field using quick search is not supported. However, when
previewing some file types, such as PDFs, you can search for text within the file.

• The configuration is not updated for the supported file extensions after users access the Digital
Asset Manager widget.

• Document previews cannot display Vietnamese text.

• When accessing assets in an external Drive, error messages may display when selecting all assets.
This can be the result of access limitations put in place by the third-party tool.

• Thumbnails of some uploaded SVG files do not display correctly.

• Previews of PPT, PPTX, DOC and DOCX files cannot display charts due to a limitation of the
library used to generate the preview.

34.12 Version 2.4.1
Released: July 2022

New features
This release contains no new features.

Attention
As the add-on is undergoing revision, the documentation's images and descriptions of some
components might not exactly match the current UI.

Changes in Functionality
This release includes no changes to functionality.

Changes to third-party libraries
The AWS Java SDK for Amazon S3 was updated to version 1.12.262.

Closed Issues
[EBXDAMA-1875] The URL generated by the Java API does not work with unrecognized file
extensions.
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Known Issues
This release contains the following known issues:

• Searching for assets in the media-type field using quick search is not supported. However, when
previewing some file types, such as PDFs, you can search for text within the file.

• The configuration is not updated for the supported file extensions after users access the Digital
Asset Manager widget.

• Document previews cannot display Vietnamese text.

• When accessing assets in an external Drive, error messages may display when selecting all assets.
This can be the result of access limitations put in place by the third-party tool.

• Thumbnails of some uploaded SVG files do not display correctly.

• Previews of PPT, PPTX, DOC and DOCX files cannot display charts due to a limitation of the
library used to generate the preview.

34.13 Version 2.4.0
Released: June 2022

New features
A new REST API was published that conforms to the Open API Specification.

Attention
As the add-on is undergoing revision, the documentation's images and descriptions of some
components might not exactly match the current UI.

Changes in Functionality
This release includes the following changes to functionality:

• Deactivated assets no longer display in the Attachments pane.

• New records can no longer be created in the Connector table.

Changes to third-party libraries
This release contains no changes to third-party libraries.

Closed Issues
This release contains the following closed issues:

• [EBXDAMA-999] The labels for the Date from and Date to icons in the Filter pane cannot be
displayed.

• [EBXDAMA-825] After previewing an asset, the other assets cannot be accessed.

• [EBXDAMA-852] The sidebar is removed after uploading a new version.

• [EBXDAMA-913] An error occurs when downloading an asset if its file name is in a language
such as Vietnamese or Chinese.
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• [EBXDAMA-1714] A default pattern class is include in the Pattern table.

• [EBXDAMA-1737] When Allow to view asset of other user is set to No, assets attached by one
user are removed after another user attaches assets.

• [EBXDAMA-1723] Handle the exception when deleting a Drive.

• [EBXDAMA-1751] An uploaded PNG file with a transparent background displays with a black
background.

• [EBXDAMA-1750] An error occurs when previewing DOC files that use languages such as
Vietnamese, Japanese, and Chinese.

Known Issues
This release contains the following known issues:

• Searching for assets in the media-type field using quick search is not supported. However, when
previewing some file types, such as PDFs, you can search for text within the file.

• The configuration is not updated for the supported file extensions after users access the Digital
Asset Manager widget.

• Document previews cannot display Vietnamese text.

• When accessing assets in an external Drive, error messages may display when selecting all assets.
This can be the result of access limitations put in place by the third-party tool.

• Thumbnails of some uploaded SVG files do not display correctly.

• Previews of PPT, PPTX, DOC and DOCX files cannot display charts due to a limitation of the
library used to generate the preview.

34.14 Version 2.3.2
Released: April 2022

New features
This release contains no new features.

Attention
As the add-on is undergoing revision, the documentation's images and descriptions of some
components might not exactly match the current UI.

Changes in Functionality
This release includes no changes to functionality.

Changes to third-party libraries
The Zip4j library was updated to version 2.10.0.

Closed Issues
This release contains no closed issues.
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Known Issues
This release contains the following known issues:

• Searching for assets in the media-type field using quick search is not supported. However, when
previewing some file types, such as PDFs, you can search for text within the file.

• The configuration is not updated for the supported file extensions after users access the Digital
Asset Manager widget.

• Document previews cannot display Vietnamese text.

• When accessing assets in an external Drive, error messages may display when selecting all assets.
This can be the result of access limitations put in place by the third-party tool.

• Thumbnails of some uploaded SVG files do not display correctly.

• Previews of PPT, PPTX, DOC and DOCX files cannot display charts due to a limitation of the
library used to generate the preview.

34.15 Version 2.3.1
Released: March 2022

New features
This release contains no new features.

Attention
As the add-on is undergoing revision, the documentation's images and descriptions of some
components might not exactly match the current UI.

Changes in Functionality
This release includes no changes to functionality.

Changes to third-party libraries
This release contains the following updates to third-party libraries:

• The Apache PDFBox and Apache FontBox were updated to version 2.0.25.

• The jQuery UI and UI widget libraries were updated to version 1.13.1.

• The jQuery library was updated to version 3.6.0.

• The Apache XML Graphics Commons library was updated to version 2.7.

• The debugger.js component was removed from the PDF.js library.

• The FasterXML/jackson-databind library was updated to version 2.13.2.1.

• The Zip4j library was updated to version 2.9.1.

Closed Issues
[EBXDAMA-1662] An error occurs in the media type field when the table has 2 primary keys and
one data type is date.
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Known Issues
This release contains the following known issues:

• Searching for assets in the media-type field using quick search is not supported. However, when
previewing some file types, such as PDFs, you can search for text within the file.

• The configuration is not updated for the supported file extensions after users access the Digital
Asset Manager widget.

• Document previews cannot display Vietnamese text.

• When accessing assets in an external Drive, error messages may display when selecting all assets.
This can be the result of access limitations put in place by the third-party tool.

• Thumbnails of some uploaded SVG files do not display correctly.

• Previews of PPT, PPTX, DOC and DOCX files cannot display charts due to a limitation of the
library used to generate the preview.

34.16 Version 2.3.0
Released: February 2022

New features
This release contains the following new features:

• A new Drive configuration property allows administrators to choose whether to allow upload of
duplicate assets to the given Drive.

• A new connector type allows a Drive location to be set to an Amazon S3 bucket. This allows you
to attach assets to fields in EBX® while managing their storage outside of EBX®.

• Actions such as deletion, deactivation, downloading, and sharing can now be performed on
multiple assets at once.

• When configured by an administrator, users now have the option of uploading and attaching assets
directly from the tabular view. This prevents having to open each record to attach assets.

• The Digital asset table now displays a thumbnail of each digital asset.

• When uploading files, any files that have errors can now be removed before uploading.

• A new API is available that allows you to create a custom connector to link a field containing
assets with a third-party tool.

Attention
As the add-on is undergoing revision, the documentation's images and descriptions of some
components might not exactly match the current UI.

Changes in Functionality
This release includes the following changes to functionality:

• The Class field is now hidden in the Pattern table.
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• Two files with the same name can now be uploaded to a Drive. The add-on automatically appends
a number increment to the file name.

• The File not found error no longer displays when all assets are removed from a Drive.

• When you delete a D.A.C, any asset modifications made in the local dataspace (that are related
to the deleted D.A.C) are lost. Assets are reset to their initial state.

Changes to third-party libraries
This release contains no updates to third-party libraries.

Closed Issues
This release contains the following closed issues:

• [EBXDAMA-591] An error message displays when opening a record that has an existing asset
in the blacklisted extension.

• [EBXDAMA-730] Error message should be shown as pop-up when deleting asset in Digital asset
version table that does not have another version.

• [EBXDAMA-761] Create new record submission is NOT prevented when there are errors in the
Pattern table.

• [EBXDAMA-774] In the Upload screen, the information related to the maximum allowed file size
and restricted file upload are not displayed even though they are set up in the Drive/ DAC.

• [EBXDAMA-795] The order of assets is changed after selecting another Drive.

• [EBXDAMA-824] The original file name is changed when a user downloads an external asset.

• [EBXDAMA-833] An incorrect error message is shown when a user tries to preview an asset from
a deleted Drive.

• [EBXDAMA-835] Can Input the letter or special character in the search page in the Manage
digital asset screen.

• [EBXDAMA-844] XLS and XLSX files don't display correctly when changing the asset's zoom
level.

• [EBXDAMA-875] Assets displayed in the Drive view don't display according to the [Mosaic]
view set in the D.A.C.

• [EBXDAMA-878] The display of the tag value is incorrect.

• [EBXDAMA-885] Unable to change Drive of existing asset via the Digital asset table in the
Administration panel.

• [EBXDAMA-893] An unexpected error message displays when leaving fields blank in the image
configuration screen.

• [EBXDAMA-906] The dropdown menu displays incorrectly when a Drive name is too long.

• [EBXDAMA-912] The wrong screen is displayed when closing the Edit digital asset screen of
sharing assets.

• [EBXDAMA-917] SVG images do not display correctly.

• [EBXDAMA-927] The error message is missing the rule pattern and it is not translated into French.

• [EBXDAMA-945] The Accept duplicate(s) checkbox does not display when uploading existing
assets.
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• [EBXDAMA-952] BMP images cannot be previewed even when smaller than 5MB.

• [EBXDAMA-1397][Rest API] The getAssetInformation endpoint returns the incorrct
calculated URL for preview_url, defaultIcon, versions.URL and versions.preview_url.

Known Issues
This release contains the following known issues:

• Searching for assets in the media-type field using quick search is not supported. However, when
previewing some file types, such as PDFs, you can search for text within the file.

• The configuration is not updated for the supported file extensions after users access the Digital
Asset Manager widget.

• Document previews cannot display Vietnamese text.

• When accessing assets in an external Drive, error messages may display when selecting all assets.
This can be the result of access limitations put in place by the third-party tool.

• Thumbnails of some uploaded SVG files do not display correctly.

• Previews of PPT, PPTX, DOC and DOCX files cannot display charts due to a limitation of the
library used to generate the preview.

34.17 Version 2.2.1
Released: December 2021

New features
This release contains no new features.

Changes in Functionality
This release includes no changes to functionality.

Changes to third-party libraries
This release contains the following updates to third-party libraries:

• The jQuery UI library was updated to version 1.13.0.

• The jQuery File Upload library was updated to the latest version.

Closed Issues
This release contains no closed issues.

Known Issues
This release contains the following known issues:

• Searching for assets in the media-type field using quick search is not supported. However, when
previewing some file types, such as PDFs, you can search for text within the file.

• The configuration is not updated for the supported file extensions after users access the Digital
Asset Manager widget.
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• Document previews cannot display Vietnamese text.

• When accessing assets in an external Drive, error messages may display when selecting all assets.
This can be the result of access limitations put in place by the third-party tool.

• Thumbnails of some uploaded SVG files do not display correctly.

• Previews of PPT, PPTX, DOC and DOCX files cannot display charts due to a limitation of the
library used to generate the preview.

34.18 Version 2.2.0
Released: November 2021

New features
This release contains no new features.

Changes in Functionality
This release includes the following changes to functionality:

• When configuring a Drive, you now select from a list of available connectors instead of Drive
types. The following connectors are available in this release:

• Default connector: Allows you to create a default Drive where asset storage and
management tasks are handled by the add-on.

• External manager: Allows you to use the API to connect to an externally managed storage
location.

• The Editor is now the Drive view and you can no longer edit asset metadata from this view.
All functionality, apart from editing, in this view remains the same. You can now access editing
features by:

• Selecting an asset's information icon when viewing a record.

• Using the Manage digital assets service (available to administrators).

• Modifications to assets are no longer autocratically global in scope. Changes are now either
isolated, or applied globally depending on your access rights, and where you initiate changes.
When changes are isolated, they only impact the current dataspace. For example, when you make
changes in a child dataspace, they do not propagate to the parent. Global changes are propagated
to any location where an asset is used. If you:

• Are a business user and access edit functionality from a record's details view, any changes
you make are isolated to the current dataspace.

• Have administrative privileges and access edit functionality using the Manage digital assets
service, changes apply globally. Note that as an administrator you can still edit from a record's
details view if you want to keep your changes local.

Note

The above behavior applies to all asset-specific information, except tags. Changes
to tags are always applied globally.
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Changes to third-party libraries
This release contains no updates to third-party libraries.

Closed Issues
This release contains no closed issues.

Known Issues
This release contains the following known issues:

• Searching for assets in the media-type field using quick search is not supported. However, when
previewing some file types, such as PDFs, you can search for text within the file.

• The configuration is not updated for the supported file extensions after users access the Digital
Asset Manager widget.

• Document previews cannot display Vietnamese text.

• When accessing assets in an external Drive, error messages may display when selecting all assets.
This can be the result of access limitations put in place by the third-party tool.

• Thumbnails of some uploaded SVG files do not display correctly.

• Previews of PPT, PPTX, DOC and DOCX files cannot display charts due to a limitation of the
library used to generate the preview.

34.19 Version 2.1.1
Released: September 2021

New features
This release includes no new features.

Changes in Functionality
This release includes no changes in functionality.

Changes to third-party libraries
The Apache Commons Compress library was upgraded to version 1.21.

Closed Issues
This release contains no closed issues.

Known Issues
This release contains the following known issues:

• Searching for assets in the media-type field using quick search is not supported. However, when
previewing some file types, such as PDFs, you can search for text within the file.

• When updating asset information in a child dataset, the parent dataset automatically updates also.
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• The configuration is not updated for the supported file extensions after users access the Digital
Asset Manager widget.

• Document previews cannot display Vietnamese text.

• When accessing assets in an external Drive, error messages may display when selecting all assets.
This can be the result of access limitations put in place by the third-party tool.

• Thumbnails of some uploaded SVG files do not display correctly.

• Previews of PPT, PPTX, DOC and DOCX files cannot display charts due to a limitation of the
library used to generate the preview.

34.20 Version 2.1.0
Released: July 2021

New features
This release includes the following new features:

• Use batch processing to automatically attach assets. Note that this feature requires the EBX®
Data Exchange (New) Add-on. See Performing bulk actions [p 85] for more information.

• You can now specify that assets must meet minimum height and width requirements for upload.

• A regular expression can now be defined in a D.A.C or Drive configuration to enforce compliance
of asset physical file names. If the name doesn't meet the specified pattern, users cannot upload
the asset.

• Performance improvements were made when:

• Importing assets with tags.

• Importing assets from a zip file.

• The Upload screen now displays additional information about the Drive and D.A.C.

Changes in Functionality
Instead of uploading assets and then validating them, the add-on saves time by preventing upload of
invalid assets. The following asset attributes are validated before upload to ensure compliance with
configuration settings:

• File size

• File extension

• Image resolution

• Max Drive size on bulk upload

• File name compliance with specified regex patterns

Changes to third-party libraries
The Apache PDFBox, Preflight, pdfbox-tools, and XmpBox libraries were updated to version 2.0.24.
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Closed Issues
This release contains the following closed issue: [EBXDMA-796] Users can see assets uploaded by
other users even when permission settings prohibit this behavior.

Known Issues
This release contains the following known issues:

• Searching for assets in the media-type field using quick search is not supported. However, when
previewing some file types, such as PDFs, you can search for text within the file.

• When updating asset information in a child dataset, the parent dataset automatically updates also.

• The configuration is not updated for the supported file extensions after users access the Digital
Asset Manager widget.

• Document previews cannot display Vietnamese text.

• When accessing assets in an external Drive, error messages may display when selecting all assets.
This can be the result of access limitations put in place by the third-party tool.

• Thumbnails of some uploaded SVG files do not display correctly.

• Previews of PPT, PPTX, DOC and DOCX files cannot display charts due to a limitation of the
library used to generate the preview.

34.21 Version 2.0.1
Released: June 2021

Updates
The following library updates were made in this release:

• The Apache PDFBox, FontBox, pdfbox-tools, Preflight, and XmpBox libraries were updated to
version 2.0.23.

• The Apache HTTPClient library was updated to version 4.5.13.

• The Apache Commons IO library was updated to version 2.8.0.

• The JAI ImageIO library was updated to version 1.4.0.

• The Zip4j library was updated to version 1.3.3.

• The Google Guava library was updated to version 30.

• The scripts.bundle.js and Google Guava version 29 were removed.

Bug fixes
This release contains the following bug fixes:

• [EBXDAMA5-567] An attached asset is hidden when its field is set to read-only in the dataset.

• [EBXDAMA5-753] When a media type field is set to 'Read-only', add-on features are still
available when viewing record details.
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34.22 Version 2.0.0
Released: March 2021

New features and updates
This release contains the following new features and updates:

• The TIBCO EBX® Digital Asset Manager Add-on has been updated to ensure compatibility with
the TIBCO EBX® 6.0.0 GA release.

• Support was added to enable the preview of XLS and XLSX files.

• The API was updated to allow you to enable and disable certain features when managing an
external Drive.

• The following updates were made to known limitations:

• The following limitation was removed: The Deactivated state is still available for user
although user does not have the right to deactivate any asset.

• The following limitation was added: Previews of PPT, PPTX, DOC and DOCX files cannot
display charts due to a limitation of the library used to generate the preview.

• The following libraries were updated or removed:

• dom4j to v2.0.3

• Jackson-databind to v2.10.0

• Apache PDFBox (Fontbox, etc …) v2.0.20

• jaxb-api-2.1.jar to v2.1 and jaxb-impl-2.1.3.jar to v2.1.3

• common-fileupload to v1.4

• poi to v4.1.2

• batik-all to v1.13

• jQuery_fileupload to v10.31

• log4j and slf4j were removed
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• APIs that were deprecated in previous versions of the add-on are no longer available. If you use
any deprecated APIs, please refer to the list below for their replacements:

Attention
All APIs in the following table are located in the com.orchestranetworks.addon.dama package.

Deprecated Replacement

AccessPermission ext.enumeration.AccessPermission

DAMException ext.exception.DAMException

DateRange ext.bean.DateRange

DigitalAsset getAssetUUID() ext.bean.DigitalAsset getAssetId()

DigitalAssetKey ext.bean.DigitalAssetKey

AbstractDigitalAssetSpec DigitalAssetSpec

DigitalAssetState ext.enumeration.DigitalAssetState

DigitalAssetVersionKey ext.bean.DigitalAssetVersionKey

DigitalAssetVersionSpec ext.bean.DigitalAssetVersionSpec

DriveFactory ext.factory

DriveManager ext.DriveManager

DriveType ext.bean.DriveType

MetaData

OperationExecutionStatus

ext.bean.MetaData

ext.exception.OperationExecutionStatus

ResourceIdentifier ext.ressource.ResourceIdentifier

ResourceIdentifierFactory ext.resource.ResourceIdentifierFactory

SearchContext

ext.bean.SearchFilter

externalmanagement.search.SearchConfig

externalmanagement.search.SearchFeature

Size ext.bean.Size

SortBy ext.enumeration.SortBy
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Deprecated Replacement

StorageManager ext.StorageManager

Version ext.bean.DigitalAssetVersion

Note

A validation error might prevent the Backup service from executing properly. If this
occurs, open the validation report and select Reinitialize validation report. Then, re-
execute the Backup service.

34.23 Version 1.8.8
Released: February 2021

Product updates
Google Guava was updated to version 30.1.

Bug fixes
[EBXDAMA5-1657] An exception occurs in the add-on when using the Manage digital asset service.

34.24 Version 1.8.7
Released: January 2021

Product updates
This release contains the following library updates:

• Apache Standard Taglibs to version 1.2.3.

• Jackson Databind to version 2.11.2.

• Batik XML utility library to version 1.13.

• Apache Common Codec to version 1.13.

Bug fixes
[EBXDAMA5-1651] Absolute URLs are not calculated as expected.
[EBXDAMA5-1656] A NullPointerException is thrown while starting EBX.

34.25 Release Notes 1.8.6
Release Date: October 20, 2020

Bug fixes
[EBXDAMA5-1590] A complete URL is required when sharing an asset by email.
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34.26 Release Notes 1.8.5
Release Date: September 18, 2020

Updated features
This release contains the following feature updates:

• The following library updates were made: jQuery to v3.5.0, jQuery UI to v1.12.1, jQuery
fileupload to v10.31, and Apache POI to v4.1.2. Additionally, DOCConverter, OfficeConverter,
PPTConverter, and PPTXConverter were updated.

• Support for the OpenJDK8 and Open JDK11 libraries has been included.

Bug fixes
[EBXDAMA5-1583] The log was updated from INFO to DEBUG mode to display more readable
results.

34.27 Release Notes 1.8.4
Release Date: June 23, 2020

New features and updates
This release contains the following feature updates:

• The add-on now provides administrators the option to activate assets when viewing them from
the Digital asset screen. To perform this action, select the Activated option from the Actions
drop-down menu.

• In the Manage digital assets screen, the Drive drop-down list is now sorted alphabetically.

• File formats listed in the Blacklisted extensions property cannot be attached from the Editor
screen.

• Behavior has been updated to improve consistency in the way error messages display.

• When an administrator moves assets from an encrypted Drive to an unencrypted Drive, the add-
on automatically decrypts assets. This functionality applies when moving assets in the opposite
manner—decrypted to encrypted.

• The error message shown when uses are not able to attach an asset has been updated.

• Support for JDK8 and JDK11 has been updated. Additionally, the docx4j, pdfbox, and jQuery
libraries have been updated.

Bug fixes
This release contains the following bug fixes:

• [EBXDAMA5-1180] [IE] The Esc key does not work correctly when previewing a document
file in full-view mode.

• [EBXDAMA5-1181] [IE] The search page service does not work correctly when previewing
document assets.
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• [EBXDAMA5-1206] [IE] The first page of a document file cannot be completely displayed in
full-view in the Editor or Manage digital assets screens.

• [EBXDAMA5-1557] With assets that have tags, the Last updated date property is updated when
saving and closing—even if there is no change to the asset.

• [EBXDAMA5-1558] In the Manage Digital Assets screen, selected tags are not cleared after
changing the Drive.

• [EBXDAMA5-1559] Loading issue exceptions that link to the DOCX4J dependency prevent
preview of DOCX files on Drives.

• [EBXDAMA5-1561] The documentation and tool tips for the Blacklisted extensions should
reflect the field behavior that listed extensions can also be separated by whitespace, semicolons,
or dots.

• [EBXDAMA5-1566] An unexpected message is given when users upload DOC/DOCX files
(about 300kb) in the UI.

• [EBXDAMA5-1581] All Drives are displayed in the Manage digital assets screen instead of the
defined Drive when running the add-on service on a perspective.

• [EBXDAMA5-1589] A NullPointerException is raised when the thumbnail displays an SVG
default icon.

• [EBXDAMA5-1590] There should be a complete URL for an asset which is shared via email.

34.28 Release Notes 1.8.3
Release Date: April 20, 2020

Updated features
When you use the REST API to retrieve an asset's URL, the returned JSON object includes the
following new response parameters:

• preview_url: The URL of the asset preview.

• defaulticon: The URL of the default file extension icon.

Bug fixes
This release contains the following bug fixes:

• [EBXDAMA5-1571] When using the add-on's REST API, the value returned in the URL field
must be the URL of the original file and not the file preview's URL.

• [EBXDAMA5-1579] If the uploaded file is >5MB, a thumbnail image based on the source file
must not be generated.

• [EBXDAMA5-1582] The DAMException log is updated when attempting to delete an asset that
has been removed.

• [EBXDAMA5-1584] An asset version cannot be deleted if its binary file has already been deleted.

34.29 Release Notes 1.8.2
Release Date: February 20, 2020
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New features and updates
This release contains the following feature updates:

• Tooltips have been added for the Drive and Tags properties when uploading assets.

• PDF files that are less than 5MB can now be previewed.

• When using the API to get an asset's URL, the parameter in the returned JSON object now matches
the protocol used in the request.

• The Editor can now be used to edit assets when using a TIBCO EBX® Cloud Instance.

• When viewing assets from a storage location managed outside of EBX®, PDF files can now be
previewed in the Editor.

• If using an externally managed Drive location, the State field is now hidden when viewing
information about an asset.

• The number of assets that can be included in a single upload has been increased to 300.

• When there are multiple versions of an asset, the displayed file size now updates to the current
version of the asset.

• The thumbnail and preview display for SVG files has been updated. If the file includes animation,
users can interact with it when previewing.

Bug fixes
This release contains the following bug fixes:

• [EBXDAMA5-1223] Duplicated tags are not hidden when users add a tag with a space character,
which already exists.

• [EBXDAMA5-1363] A TableTrigger is fired in the add-on even when there is no change in the
record.

• [EBXDAMA5-1384] An error message should be raised when uploading assets on the Editor
screen through a deleted D.A.C.

• [EBXDAMA5-1435] A deactivated asset is missing in the attachment pane when it is deactivated
from the Manage digital assets screen.

• [EBXDAMA5-1458] The loading icons are not aligned with other thumbnails in the list when
quickly uploading multiple assets from the  Edit digital asset screen.

• [EBXDAMA5-1459] Unexpected behavior occurs when uploading a file to create a new version
from the Media type field.

• [EBXDAMA5-1465] The API's UIWidget to disable modifications in the editor does not work.

• [EBXDAMA5-1470] The system is not responsive after double-clicking on assets.

• [EBXDAMA5-1471] A null pointer exception is thrown when the ExternalManager's getTags
API returns null.

• [EBXDAMA5-1472] Users cannot preview assets in an external Drive from the Edit digital
asset screen.

• [EBXDAMA5-1473] After changing the label of a dataset, the download button is not available
on the Edit digital asset screen.
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• [EBXDAMA5-1475] Incorrect behavior occurs when accessing a perspective using the [ebx-
addon-dama] Manage digital assets service.

• [EBXDAMA5-1485] [API - External Management] Change the default value for All file
extensions from 0 to "".

• [EBXDAMA5-1496] A blank screen briefly appears when attaching a large number of assets.

• [EBXDAMA5-1502] An asset cannot be shared via email on the Digital Asset Manager - Editor
screen on a Relational model.

34.30 Release Notes 1.8.1
Release Date: December 10, 2019

Updated behavior
The add-on no longer refreshes data model schemas by retrieving a list of all registered models in
the repository.

34.31 Release Notes 1.8.0
Release Date: November 8, 2019

New features and updates
The following sections highlight the new features and updates for this release:

• Features and enhancements [p 179]

• API updates [p 180]

Features and enhancements
• You now have the option of enabling encryption upon Drive creation. This option encrypts all

assets in a Drive so they can only be accessed by a user logged in to EBX®.

• When uploading multiple files, asset thumbnails now display immediately after upload of that
asset is complete.

• A Drive can now be configured to access an externally managed storage location. For example,
assets might be stored in the cloud on Google Drive or AWS. Alternatively, you might already
use a third-party tool to manage digital assets but, you want to enable data model access to these
assets. Note that API implementation is required for these types of use cases.

• To improve user experience in certain deployment environments, Spring configuration has been
moved from hybrid to pure Java.

• It is no longer mandatory for Digital Asset Components to have associated tag clouds.

• A result page now displays after running the Delete all assets in Drive service.

• By default all file types are now supported and enabled for upload by the add-on. However, you
can use two new properties Restrict file upload and Blacklisted extensions to whitelist and
blacklist file extensions, respectively. See, Whitelisting and blacklisting file formats [p 67] for more
details.

• SVG files are now supported.



Documentation > Release Notes > All release notes

TIBCO EBX® Digital Asset Manager Add-on 180

API updates
Using the add-on's API you can now access externally managed storage locations. These locations
can include assets managed by third-party tools. In addition to linking to and displaying these assets
in EBX® data model fields, you can:

• Search for and filter assets.

• Enable upload and deletion of assets.

• Attach and detach externally managed assets to EBX® data model fields.

• Display externally managed tags.

Known limitations
This release contains the following limitations:

• When accessing assets in an external Drive, error messages may display when selecting all assets.
This can be the result of access limitations put in place by the third-party tool.

• Without width and height measurements, the thumbnail and content of an SVG asset are not
properly displayed.

Bug fixes
This release contains the following bug fixes:

• [DAMA-1330] The Vietnamese title of a downloaded file is wrong.

• [DAMA-1335] A thumbnail label that contains HTML elements is not correctly displayed in the
Edit digital asset screen.

• [DAMA-1336] On the list view mode the thumbnail of an asset overlaps the outer border of the
media type field.

• [DAMA-1337] Label and description value is not saved after being modified in the Digital
asset table.

• [DAMA-1338] An user-unfriendly error page displays in the Editor and Manage digital assets
screens when users attempt to download a non-existent asset.

• [DAMA-1348] The error icon displays incorrectly when using quick upload.

• [DAMA-1359] The Select all button does not work on the Editor screen after assets have been
detached.

• [DAMA-1376] The loading icon is not aligned with other thumbnails in the row when quickly
uploading an asset.

• [DAMA-1381] Assets cannot be displayed on the field when they are attached from the Editor
screen and the view mode has been changed in the D.A.C.

• [DAMA-1391] [Chrome] Incorrect behavior is presented when user selects the Apply checkbox
on the search pane.

• [DAMA-1420] A redundant header appears on the upload modal dialog from the Icon field on
File extension record.
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34.32 Release Notes 1.7.0
Release Date: June 20, 2019

New features and updates
The following sections highlight the new features and updates for this release:

• Features and enhancements

• API updates

Features and enhancements
• The Manage digital assets service can now be launched from EBX® perspectives. The service

can allow users control over assets linked to one or more Drives.

• When choosing a new asset as the current version, the new asset's file name can be automatically
populated to the Editor using the new Update label option.

• Add-on performance has been improved when a schema refresh is required.

• The Jackson library has been upgraded due to a security issue.

• The PhotoSwipe library has been removed from the add-on.

• When playing asset videos from within the add-on, the video is now streamed instead of
downloaded.

• An asset thumbnail can now be displayed in EBX® tables. See Enabling thumbnail display and
upload in the tabular view [p 26] for more information. The following image shows an example
of this feature:

API updates
The API now includes the following; please refer to the Java API documentation for additional
information and samples:
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• The API now permits assets managed by third-party tools to be linked to data model fields.

• A custom filter can now be implemented that determines the assets displayed when users enter
the Editor.

• Sample code has been added to demonstrate implementing cloud storage for assets.

• The Digital Asset UIBean has been replaced by CustomWidget.

Bug fixes
This release contains the following bug fixes:

• [DAMA-1028] Text overlap occurs in the PDF version.

• [DAMA-1048] Grant permission while calling DAM API in Script tasks.

• [DAMA-1188] The loading icon persists when previewing a large video (more than 164MB).

• [DAMA-1196] A blank page is shown when users access document files on UI Bean when the
drive has been deleted by another user.

• [DAMA-1197] An error is raised when accessing assets on UI Bean if the D.A.C. has been deleted
by another user.

• [DAMA-1249] A blank space appears on the 'Edit digital asset' and 'Import a new version' screens.

• [DAMA-1255] The error message must be unified when user accesses an asset on DAM UI Bean
in case the asset or the D.A.C. is deleted.

• [DAMA-1256] An unreasonable message is given when user downloads assets from different
screen.

• [DAMA-1259] The scroll bar does not move down to the newest point on the upload modal
screen.

• [DAMA-1269] The search page box does not work when previewing document assets in Internet
Explorer.

• [DAMA-1285] The error message must be unified when a user accesses an asset on the Editor
if the asset or the D.A.C. is deleted.

• [DAMA-1287] Large videos (more than 164MB) cannot be downloaded.

• [DAMA-1292] Error log at runtime occurs when deploy an add-on using UI Framework.

• [DAMA-1294] A tag cannot be created when a user re-selects an existing tag on upload modal
screen.

• [DAMA-1298] A NullPointerException occurs while registering DriveManager.

34.33 Release Notes 1.6.0
Release Date: March 25, 2019

New features and updates
The following sections highlight the new features and updates for this release:

• General updates [p 183]

• Updates to the UI [p 183]
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General updates
This release contains the following new features and updates:

• The add-on now supports TIBCO EBX® restriction policy functionality for user permissions.

• A programmatic filter can now be used to filter assets displayed in the editor.

• The baseURL parameter has been removed from the DigitalAsset.getURL() method.

• A public REST service has been provided to upload an asset.

• Documented code samples have been updated.

• Support has been added to take into account the new version of the TIBCO EBX™ Information
Search Add-on (2.4.0).

Updates to the UI
• The Manage digital assets UI has been updated.

• The following updates were made to the Editor UI:

• The UI is now responsive and automatically resizes based on the window or screen size.

• Infinite scroll has been added to the Editor for assets and tags.

• As highlighted in the image below, the UI layout has also been updated:

Bug fixes
This release contains the following bug fixes:
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• [DAMA-745] The title of the download pop-up is incorrect when running the Import from a
ZIP file service.

• [DAMA-1064] A JavaScript error is raised in Internet Explorer when cancelling an upload.

• [DAMA-1154] No message is given when user imports a ZIP file exceeding available server
space.

• [DAMA-1187] The user can change the current version without having sufficient permission.

• [DAMA-1200] [IE] The error icon's red border no longer displays when a user hovers their mouse
over the icon.

34.34 Release Notes 1.5.1
Release Date: December 14, 2018

Featured updates
The Creative Commons license has been moved from ECI to BAS.

Bug fixes
This release contains the following bug fixes:

• [36575] The Identify unused asset service does not work with assets on the media type field
under a group.

• [36577] The Identify unused asset service does not work with assets on the media type field
under a table belonging to a group.

34.35 Release Notes 1.5.0
Release Date: October 26, 2018

New features and updates
This release contains the following new features and updates:

• The new Change physical root path service allows you to update a Drive's storage location.
Once updated all add-on related assets are migrated to the new location.

• REST services for TIBCO EBX™ GO Add-on have been implemented.

• Significant updates have been included to ensure compatibility with the EBX® 5.9.0 GA release.

Bug fixes
This release contains the following bug fixes:

• [20798] The Permanently delete digital asset  and Delete digital asset version services do not
work on a hierarchy view.

• [26790] Lack of a border and a text overflow when a tag has long text.

• [28668] Users cannot create tags containing quotation marks on the Upload new digital assets
dialog.

• [28993] Users are not allowed to close the Upload pop up while uploading assets.
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• [29229] Inconsistent display of Upload and Edit buttons between a media type field using Quick
upload and attach and the UI.

• [29300] The display of service buttons on the thumbnail of asset on the Digital Asset Manager
UI Bean are inconsistent.

• [30085] An error message occurs when users click Select all  after detaching assets including the
File not found items.

• [32131] The upload files process does not work properly.

• [33465] The search pane's tooltip on the Editor / Manage digital asset screen is wrong.

• [33545] An incorrect tooltip is displayed for the Cancel button in the Importing assets screen.

34.36 Release Notes 1.4.3
Release Date: November 29, 2018

Featured updates
The Creative Commons license has been moved from ECI to BAS.

Bug fixes
This release contains the following bug fixes:

• [36578] The Identify unused asset service does not work with assets on the media type field
under a group.

• [36581] The Identify unused asset service does not work with assets on the media type field
under a table belonging to a group.

34.37 Release Notes 1.4.2
Release Date: September 13, 2018

Featured updates
The Digital Asset Manager Add-on has undergone updates to ensure compatibility with the EBX®
5.8.1 fix M release.

34.38 Release Notes 1.4.1
Release Date: June 22, 2018

Bug fixes
[33653] Files cannot be uploaded due to a conflict with the jQuery library.

34.39 Release Notes 1.4.0
Release Date: May 2, 2018
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New features
The following sections describe new features for the GA 1.4.0 release:

• Previewing assets [p 186]

• Importing assets in bulk [p 187]

• Record filtering [p 187]

• REST services [p 189]

Previewing assets
The add-on now includes the ability to preview additional types of assets. See Previewing assets [p 35]

for more detailed information. The newly supported types are:

• MP4 files: When previewing, the add-on automatically starts the video and enables basic playback
control.
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• Document files: When previewing PDF, DOC, DOCX, PPT, or PPTX assets you can use standard
document viewer features, such as zoom, navigation, and search.

Importing assets in bulk
Administrators now have the option to perform a bulk upload of assets by importing a ZIP file. After
import, the Result page's Actions menu enables:

• Download of a log file if the import failed.

• Comparison of two or more imported assets.

• Export of the report in CSV or XML format if the import was successful.

Record filtering
The add-on now provides the ability to filter the following types of records:



Documentation > Release Notes > All release notes

TIBCO EBX® Digital Asset Manager Add-on 188

• Asset records that are not attached to a field. The new Identify unused assets service locates and
displays all assets not attached to a field. From this view you can compare assets and export reports
in CSV and XML formats. For more information, see Finding and removing unused assets [p 69] .
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• Table records with no attached assets. The EBX® filter now contains the Digital Asset Manager
Add-on search  filter. The filter can be used to show/hide records that have attached assets. For
more information, see Configuring asset filters [p 39] .

REST services
REST services are now available to:

• Get all digital assets from a Drive.

• Attach and detach assets from a field.

See REST service operations (deprecated) [p 99] for examples.

Known limitations
This release contains the following limitations:

• A JavaScript error is raised in Internet Explorer when canceling an upload.

• The progress bar does not work properly when importing from a ZIP file.

• Document previews cannot display Vietnamese text.

• The video seek bar does not work properly when a user previews MP4 files in Google Chrome.
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Bug fixes
This release contains the following bug fixes:

• [30757] Users can still view assets in the Editor after another user has deactivated the asset.

• [30769] Users can view other's assets even without sufficient permission in the D.A.C. or Drive.

• [32140] An error occurs on the loading page when clicking the 'Reset filter' button on the Editor
screen.

34.40 Release Note 1.3.0
Release Date: December 15, 2017

Overview of features and enhancements
• Usability improvements [p 191]

• A new Information icon is available on asset thumbnails. Clicking this icon opens the Edit
digital asset screen where you can view detailed information about the asset, its versions, and
its metadata.

• You now have the option of determining whether quick action icons always display on assets, or
only when users mouse over the asset.
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• When viewing asset versions, you can now download individual versions for comparison.

• New REST services are available that allow you to:

• Retrieve an asset's URL.

• Get all mediaType fields registered in Digital Asset Manager Add-on.

• Get information about assets attached to a mediaType field.

Usability improvements
A large portion of the asset management process involves getting your assets into the manager. With
this in mind, the latest version of the Digital Asset Manager Add-on provides the following usability
improvements focused on helping you during the upload process (see Uploading and attaching assets
[p 27] for more information):

• Instead of bringing in assets individually, you can now upload and attach more than one asset
at a time.

• A new quick-upload mode allows users to bypass pop-up dialogs and directly upload and attach
assets. This mode integrates well with workflows.

• In addition to browsing to select files, drag-n-drop functionality is now included in the upload
screen.

• Duplicate asset management during upload has been improved. The upload screen now indicates
which assets are duplicate and you can choose whether to keep, or remove these assets during
upload.

• When browsing for files to select during upload, the add-on applies a filter and only displays
those extensions supported by the current D.A.C. configuration.
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The following image highlights some of the aforementioned features:

Bug fixes
• [28586] The 'Tag' text box disappears in the 'Manage digital assets' screen after removing tag on

an asset.

• [28623] The 'Drive' field is null and Tags are displayed after changing value of 'Drive' in the
D.A.C.

• [28675] An error occurs on the Digital Asset Manager UI Bean and an exception is thrown in the
log when users use an uncompleted list view.

• [28839] An error occurs and an exception is thrown in the log when running 'Attach' or 'Detach
with an uncompleted list view.

• [28846] A record cannot be created by using 'Duplicate record' on 'Drive' table in the 'TIBCO
EBX™ Digital Asset Manager Add-on' dataset.

• [28871] An error occurs when the media type field is in a group with multiple elements.

• [28877] A newly uploaded asset is attached into the first occurrence in spite of being uploaded
from another media type field.

• [28883] Overlap occurs in the 'Editor' screen on IE8.

• [28886] Users can create an image configuration even when the mandatory fields of 'Max width'
and 'Max height' are empty.

• [28887] The 'Bin' icon is displayed without thumbnail on the Digital Asset Manager UI bean after
detaching the asset on IE8.

• [29304] A user can still open the Editor screen without sufficient permission.
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• [29722] An unsupported file can be attached to the 'File attachments' pane on the Editor screen.

• [29836] An exception is thrown in the log when inputting a value into the 'Metadata' table without
choosing 'Metadata nature'.

34.41 Release Note 1.2.2
Release Date: November 7, 2017

New features
• You can now download assets contained in read-only records.

• It is now possible to upload a new asset version from the list view.

• A new REST service is available to retrieve a digital asset's URL.

34.42 Release Note 1.2.1
Release Date: October 16, 2017

New features
• Take into account the new version of TIBCO EBX™ Information Search Add-on (2.0.0).

34.43 Release Note 1.2.0
Release Date: September 6, 2017

New features

UI updates and improvements
• The Editor layout has been improved.

• Assets can be displayed in fields using a combination of settings that include using thumbnails,
or icons and using a list, or tiled mosaic view.

• Display of asset thumbnails has been improved and also retains an image's original aspect ratio.

Functionality improvements
• User permissions have been expanded and can now be set at the Drive and D.A.C. levels.

• In the Editor, assets can be selected to shown an expanded view. Several options for downloading,
editing, and sharing are available from the expanded view.

• Search, sort, and filter options available in the Editor have been updated.

• An asset's label description, version name and comments, and tags can be modified during upload.

• The following actions can be performed when mousing over an asset thumbnail: detach,
download, or import of a new version.

• Tag domains have been replaced with tag clouds. Tag clouds can be used to organize tags and
display them in the Editor.

• Duplicate assets can now be uploaded.
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• Uploaded assets are saved in sub-folders so that the limitations of certain file systems don't prevent
the upload of additional assets.

Bug fixes
• [25631] Users cannot run the Restore service when they do not have delete permission on a Drive

contained in the backup file.

• [26113] There is a redundant 'Upload new digital asset' dialog when users upload an asset.

• [26114] There is an error when clicking a thumbnail that has been accidentally deleted in the
file system.

• [26115] An asset's label displays incorrectly when users input HTML characters.

• [26116] A 403 page error occurs when users click on the download button from Digital Asset
Manager UI Bean.

• [26117] Multiple errors occur when users input HTML characters into Domain and Tag domain.

• [26118] The tooltip of an asset is not updated after running the Refresh service.

• [26119] [Configuration] An error occurs after clicking on the 'Create a record' button in the
'History' table.

• [26120] [IE] The label and textbox of the 'Domain' field are not positioned correctly.

• [27962] An unknown record is automatically created in the 'Digital Asset Type' table.

34.44 Release Note 1.1.1
Release Date: August 16, 2017

Bug fixes
• [27520] A 'Drive type' that connects to cloud storage cannot be created.

34.45 Release Note 1.1.0
Release Date: April 18, 2017

New features
• A new public API is available to create, update, and delete digital assets and versions. It also

allows connection to additional types of drives.

Bug fixes
• [25406] The system returns incorrect results when filtering label and domain.

• [25413] The 'Last update date' is not updated after users update domain and tag of an asset.

• [25438] Unauthorized access to resources is possible.

Warnings
• Customers are strongly advised to upgrade to the latest version which patches the security

issue.
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34.46 Release Note 1.0.2 fix 001
Release Date: April 18, 2017

Bug fixes
• [25508] Unauthorized access to resources is possible.

Warnings
• Customers are strongly advised to upgrade to the latest version which patches the security

issue.

34.47 Release Note 1.0.3
Release Date: April 3, 2017

Bug fixes
• [22873] Even when users deactivate a digital asset, it still appears in the 'Digital asset list' pane,

'Attached' pane, and 'Media' field.

• [22879] The wrong current version of digital asset is downloaded.

• [22917] There is an error when previewing the digital asset when the file has been accidentally
deleted in the file system.

• [24361] The digital assets cannot be loaded when the 'Digital asset type' option is set to 'image'.

• [24661] After modifying business version or comment, the system uploads the previously selected
file again.

• [24677] Domain for a digital asset cannot be created when the 'Domain' field contains special
characters.

• [24723] An unexpected error occurs in version management tab when displaying a digital asset
without setting the current version.

• [24825] An unexpected error occurs when a digital asset has no label.

• [24871] Digital asset is not deleted after users click the 'Cancel upload' button.

• [25116] An unexpected error occurs when users modify ebx.locales.available=en in
ebx.properties.

34.48 Release Note 1.0.2
Release Date: January 23, 2017

New features
• When specifying a Drive's storage location using the 'Physical root path' property it is now

possible to use a relative path.
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Bug fixes
• [24115] Abnormal behavior is recorded when importing an EBX® file.

34.49 Release Note 1.0.1
Release Date: October 28, 2016

New features
• Images that use the CMYK color space can be managed with the Digital Asset Manager Add-on.

34.50 Release Note 1.0.0
Release Date: October 12, 2016

New features
• A 'Media-type' field can be added to a data model to enable digital asset management.

• Assets can be uploaded using the add-on's services supplied at the administrative, dataset and
field levels.

• An editor is available that allows you to perform the following actions on digital assets: upload,
select, deselect, search, filter, edit, preview, download, share, deactivate and delete.

• Several custom services are available that allow you to perform asset management-specific
actions in. The services are covered in more detail in the main documentation.

• It is possible to create a backup of, and restore the Digital Asset Manager Add-on's configuration
settings and assets.
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